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Thank you for purchasing the CASIO FIVA MPC-501.
This guide describes the basic operations of the
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Read this guide in its entirely before handling or
operating the product, and keep it close at hand so it
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Notes
• This guide cannot be reproduced or duplicated in any form, in part or in whole, without

written permission from CASIO COMPUTER CO., LTD.
• The content of this guide is subject to change without notice.
• CASIO has, to the best of its ability, endeavored to make this guide as accurate as possi-

ble. However, if any unclear portions or omissions are found, please contact your dealer.

Descriptions and specifications furnished herein the User’s Guide by CASIO Computer Co.,
Ltd. are believed to be accurate and reliable. However, CASIO reserves the right to make
changes or improvements in the descriptions and specifications without any advanced notice.
CASIO does not assume any liability arising from the use of the contents, nor for any
infringements of patents or other rights of third parties which may result from the use of the
contents.

• Microsoft, MS-DOS and Windows are registered trademarks of Microsoft Corporation in

the United States and/or other countries.

• PS/2 is a registered trademark of International Business Machines Corporation in the

United States.

• smARTwriter, smARTscribble and Quick Trainer are trademarks or registered trade-

marks of Advanced Recognition Technologies in the United States.

• Other company, product and service names used herein may also be trademarks or

service marks of respective companies.

International ENERGY STAR® Program
As a member of the International ENERGY STAR®

Program, CASIO products have been judged to
meet International ENERGY STAR®  standards.
ENERGY STAR®  is a U.S. registered mark.

Power Plug and AC Adaptor

Note
AC cord plug and wall outlet illustrated in this User’s Guide shows the
two-pin plug type. It may not be the same shape of AC cord plug used
in your area.
FIVA’s AC adaptor has an automatic voltage switching circuit (input:
100 to 240VAC, 50/60Hz) and lets you use your FIVA under AC power
virtually anywhere in the world without having an extra power-transformer.
Note, however, that AC cord plug shape differs according to area you
are in. Make sure that the AC cord you will use can fit into wall outlet
and is compliance with the local electric safety standard.

© 2001 CASIO COMPUTER CO., LTD. All rights reserved.

MPF0101098-01
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• Do not dispose of the box and packing materials. Use the box and packing materials
for storage and transport.

FIVA501
User’s Guide

Windows98

First Step Guide

FiVACD

Keep in a safe place

Packing List

Thank you for purchasing the CASSIOPEIA FIVA MPC-501 series. A list of the items
included with this product is given below. Confirm that nothing is missing or damaged.
If anything is missing or damaged, contact the dealer from which you purchased this
product.

FIVA MPC-501

Stylus Screen protective film

AC adaptor

Neck strap

Battery pack

User’s Guide

 ID sticker

Windows98 SE
First Step Guide Product

Recovery CD-ROM

(Not included with the
MPC-501M63O)

(Standard with the MPC-501M62E)

Moduler cable
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Safety Precautions

• To use this product safely and correctly, read this User’s Guide
thoroughly and operate as instructed.
After reading this guide, keep it close at hand for easy reference.
Please keep all informations for future reference.

• Always observe the warnings and cautions indicated on the product.
• If this guide is misplaced or damaged so as to be unreadable, a

new one can be ordered. To obtain a new User’s Guide, contact the
dealer from which this product was purchased.

About the icons

In this guide various icons are used to highlight safe operation of
this product and to prevent injury to the operator and other
personnel and also to prevent damage to property and this
product. The icons and definitions are given below.

Indicates that there is a risk of severe injury or death if used incorrectly.

Indicates that injury or damage may result if used incorrectly.

Icon examples
To bring attention to risks and possible damage, the following types
of icons are used.

The  symbol indicates that it includes some symbol for attracting
attention (including warning). In this triangle the actual type of
precautions to be taken (electric shock, in this case) is indicated.

The  symbol indicates a prohibited action. In this symbol the
actual type of prohibited actions (disassembly, in this case) will be
indicated.

The  symbol indicates that a restriction. In this symbol the type of
actual restriction (removal of the power plug from an outlet, in this
case) is indicated.

 Warning!

 Caution!



3

 Warning!

Handling FIVA

Should FIVA malfunction, start to emit smoke or a
strange odor, or otherwise behave abnormally,
immediately shut down the power, remove batteries,
and unplug the AC adaptor from the power outlet.
Continued use creates the danger of fire and electric
shock.
• Contact your original retailer or authorized distributor.

Do not place containers of liquids near FIVA and do
not allow any foreign matter to get into it. Should
water or other foreign matter get into FIVA,
immediately shut down the power and unplug the AC
adaptor from the power outlet. Continued use creates
the danger of shorting, fire and electric shock.
• Contact your original retailer or authorized distributor.

Never bring in FIVA a bathroom or any other location
where the possibility of splashing or high humidity
exists. Use of FIVA in such an area creates the danger
of electric shock. Be especially carefully when using
FIVA while rain or snow is falling, or in beach areas.

Never try to take FIVA apart or modify it in any way.
High-voltage components inside FIVA create the
danger of fire and electric shock.
• Contact your authorized distributor for all repair and

maintenance.

Should you drop FIVA and damage it, immediately
shut down the power and unplug the AC adaptor from
the power outlet. Continued use creates the danger of
shorting, fire and electric shock.
• Attempting to repair FIVA yourself is extremely

dangerous. Contact your authorized distributor for all
repair and maintenance.
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 Warning!

The liquid inside the LCD is harmful to humans. Never
touch it or allow it to get in your mouth.
• Should liquid from the LCD panel accidentally get into

your mouth immediately wash out your mouth with
clean water. If it gets onto your skin, immediately rinse
for at least 15 minutes with clean tap water. In either
case, consult a physician.

Power Plug and AC Adaptor

Note
AC cord plug and wall outlet illustrated in this User’s Guide shows the
two-pin plug type. It may not be the same shape of AC cord plug
used in your area.

Use only a proper AC electric outlet (100V~240V)
when powering FIVA with the AC adaptor. Use of an
outlet with a different voltage from the rating creates
the danger of malfunction, fire, and electric shock.
Overloading an electric outlet creates the danger of
overheating and fire.

Make sure the power plug and AC adaptor plug are
inserted as far as they will go. Loose plugs create the
danger of electric shock, overheating, and fire.
• Do not use the adaptor if the plug is damaged. Never

connect to a power outlet that is loose.

Use a dry cloth to periodically wipe off any dust built
up on the prongs of the plug. Humidity can cause
poor insulation and create the danger of electric
shock and fire if dust stays on the prongs.

Do not allow the power cord or plug to become
damaged, and never try to modify them in any way.
Continued use of a damaged power cord can cause
deterioration of the insulation, exposure of internal
wiring, and shorting, which creates the danger of
electric shock and fire.
• Contact your authorized distributor whenever the power

cord or plug requires repair or maintenance.

AC100~240V
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 Warning!

Use only the AC adaptor specified by CASIO for this
product. Use of another type of AC adaptor creates
the danger of fire.

Use only the battery pack that comes with FIVA. When
the battery pack reaches the end of its life, replace it
with a new battery pack as specified by CASIO. Other
types of batteries have different voltage rating and
polarity, which creates the danger of fire and bursting
of the batteries.

Never try to take the battery pack apart or modify it
in any way. Doing so creates the danger of
overheating, fire, and bursting of the battery pack.

Never throw the battery pack into fire or otherwise
expose it to direct flame. Doing so creates the danger
of fire and explosion.

Never allow the positive (+) and negative (–) poles of
the batteries to become connected by metal. Do not
store or transport the battery pack together with metal
necklaces, hairpins, or other metal items. Connection
of the battery pack poles creates the danger of
overheating, fire, and explosion.
• When transporting or storing the battery pack, wrap it

in plastic to keep the poles away from metal items that
might cause a short.

Never allow the battery pack to be exposed to water
or moisture. Moisture creates the danger of
overheating, fire, and explosion. Should the battery
pack ever become wet, immediately stop using it.
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 Caution!

Do not place FIVA on an unstable or uneven surface.
Doing so can cause FIVA to fall, creating the danger
of malfunction, fire, and electric shock.

Do not leave FIVA in the following areas.
• Areas where FIVA will be subject to large amounts of

humidity or dust, or directly exposed to hot or cold air.
• Areas exposed to direct sunlight, in a close motor vehicle,

or any other area subject to very high temperatures.

The above conditions can cause malfunction or
deformation of FIVA, which creates the danger of fire.

When transporting FIVA, take care to avoid subjecting
it to vibration and impact. This unit contains a hard
disk and other precision components that can be
damaged by rough handling.

The AC adaptor normally becomes warm during
use. Avoid allowing the AC adaptor to rest on your
lap or other part of your body when using it for
long period. Long term with the AC adaptor creates
the danger of burns.

Do not overly bend the power cord, do not allow it to
be caught between desks or other furniture, and
never place heavy objects on top of the power cord.
Doing so can cause shorting or breaking of the power
cord, creating the danger of fire and electric shock.
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 Caution!

Be sure to grasp the plug when unplugging the power
cord from the wall outlet. Pulling on the cord can
damage it, break the wiring, or cause short, creating
the danger of fire and electric shock.

Never touch the plug while your hands are wet. Doing
so creates the danger of electric shock. Pulling on the
cord can damage it, break the wiring, or cause short,
creating the danger of fire and electric shock.

Avoid use in areas where the brightness around the
display is very different from surrounding lighting, or
where the sunlight is shining directly on the display.
Such conditions can cause eye fatigue.
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Before Using FIVA

• This product has been designed and manufactured under stringent
quality control. Should you suspect FIVA is defective or
malfunctioning, contact your original dealer or authorized
distributor. Repair and maintenance are subject to the terms and
conditions of the Warranty.

• CASIO COMPUTER CO., LTD. shall not be held liable for any loss
or claims due to using this product except as instructed to do so in
this User’s Guide.

• CASIO COMPUTER CO., LTD. shall not be held liable for any loss
or claims (lost profits, interruption of business, corruption or loss of
memory data, etc.) by you or any third party due to the use of this
product or the inability to use this product for a specific purpose,
except as specifically stipulated by law.

• Unauthorized copying of this product or its software is prohibited.
• This product is guaranteed only when operating under the version

of Windows 98 that comes bundled with it.

Product Application
• This product is intended for use as a general office computing

device.
• CASIO makes no warranties that this product is fault-tolerant. It is

not designed, manufactured or intended for use in any equipment
or system (such as traffic control devices, safety devices, medical
devices, etc.) where the malfunction or misoperation of FIVA could
lead directly to death, personal injury, or serious damage to
physical assets.

System Recovery
• This product comes with Windows 98 and a collection of utility

software pre-installed on its hard disk. Should the system start to
malfunction or produce errors, you can use the “Product Recovery
CD-ROM” that comes with FIVA to restore the factory default
system. This returns FIVA the same settings and state it was in
when you originally purchased it.

Note Windows 98 and other software are not pre-installed in the MPC-
501M63O.
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Computer Viruses

Avoiding Computer Viruses
A computer virus is a program. It gets installed on your system
without you being aware of it, and can do anything from displaying
strange messages to destroying your data and other programs. A
virus can enter your system via a floppy diskette or network. Taking
the following precautions are normally sufficient to protect against
having a virus invade your system.

• Write protect the master copies of your programs and data files.
• Never open data files or run programs of unknown origin.
• Use a commercially available virus checker to check new

programs, and periodically check your system for virus
contamination.

Use the latest version of a commercially available virus
checker to check your system.
An immediate virus check is recommended in the following cases.

• Check your system each time you start up your computer.
• Check any data file or program you received on a floppy diskette or

other external media, over a network, from a BBS or the Internet,
via e-mail, etc. before opening the file or running the program.
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FIVA

Precaution Label
• The label shown above is affixed to the bottom of FIVA. Be sure to

carefully observe these precautions at all times. Never remove this
label. Should this label ever start to come off or should its contents
become unreadable, contact your original dealer or authorized
distributor.

Power Requirements
• Plug the AC adaptor into a power outlet rated for 100V to 240V AC,

50/60Hz only.
• Do not connect FIVA to the same outlet of another device that

generates electrical noise. Such a device can corrupt data in FIVA.

Turning Off Power
• Never unplug the power cord or otherwise cut off power to FIVA

while the system is starting up or while a program is running. Doing
so can cause data to be lost or corrupted, and can lead to
malfunction of FIVA.

• Do not turn power off and then suddenly back on again. Doing so
can cause data to be lost or corrupted, and can lead to malfunction
of FIVA.

Cables
• Use only the cables that come with FIVA to connect it to other

optional equipment.
• Never pull on cable or place a heavy object on it. Doing so can

cause the cable to break or short.

Caution
• Turn off this product before connecting or

disconnecting peripherals.
• Never apply impact or vibration.
• Never take this product apart.
• Use only the specified AC adaptor.
• The bottom of this product becomes warm

during use. Avoid using it in your lap for a
long period.
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Avoid Strong Vibration and Impact
• Strong vibration or impact can cause malfunction. Be particularly

careful when FIVA is turned on. Vibration and impact can cause
corruption of data on built-in hard disk.

Transporting FIVA
• Be sure to shut down the power and disconnect all options (port

replicator, CD-ROM drive, etc.) before removing FIVA. Leaving
cables connected while removing FIVA can damage the cables
and creates the danger of accident.

• Store FIVA in its case whenever you are transporting it or not using
it. Doing so protects FIVA against damage.

Avoid Water and Moisture
• FIVA is not water resistant. Never use or store FIVA where there is

the danger it might become exposed to water or moisture.

Options
• Be sure to carefully follow the procedures provided in the

applicable User’s Guides whenever connecting or disconnecting
peripherals. Failure to do so can damage FIVA or the peripheral.

AC adaptor: WARNING
• Use AC adaptor type MPC-577ADP (SQS45W16P-02).

Main battery: WARNING
• Replace this main battery with Model MPC-173BAT or MPC-

174LBAT.
Use of another battery may present a risk of fire or explosion.

• This battery pack is suitable for use only with MPC-501 series.
• Keep away from children.
• Dispose of used batteries according to the manufacturer’s instruction.

Non-CASIO options
• Check with each manufacturer for compatibility before using any

non-CASIO options with this unit.
• CASIO assumes no responsibility for any loss (including but not

limited to personal injury, material loss, damage to FIVA) suffered
by you or other arising out of the use of a non-CASIO option.

Use Only as Directed
• Be sure to connect or disconnect an option only as expressly

directed in the documentation that comes with the option.
• Incorrect use of options can cause malfunction and serious damage

to FIVA, which can required extensive repair work to correct.
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Floppy Diskette and Hard Disk Data

Disk Operations
• A lit hard disk drive or floppy disk drive access lamp indicates that

a disk operation is being performed.
• Never shut down while a hard disk drive or floppy disk drive

operation is being performed. Also, never eject the floppy diskette
while a floppy disk drive operation is being performed. Doing so
can make data or applications on the disk unusable.

Backup Data
• You should occasionally back up data on the hard disk by copying

it to floppy diskette. This ensures that you always have backup data
on hand in case of accidental data deletion or corruption caused
by mis-operation, malfunction, maintenance, etc.

Note that CASIO is not liable for any losses suffered by you or
any third party due to the loss of data stored on FIVA’s hard
disk.

Formatting a Floppy Diskette
• Formatting a floppy diskette deletes all data stored on it.
• Be sure to check the contents of a floppy diskette before formatting

it.

CD-ROM

Protecting CD-ROMs from Dirt and Dust
• Keep CD-ROMs in their original cases, and store them in a safe

place.
• Handle CD-ROMs by pinching between two fingers, one inside the

center hold and one on the outside edge of the disk.
• Never bend a CD-ROM, write on its surface, or allow its surface to

become damaged.
• Do not affix labels to a CD-ROM.
• Keep CD-ROMs out of direct sunlight and areas exposed to

extreme heat or cold.
• To clean a CD-ROM, wipe it with a soft dry cloth. Wipe from the

center outwards to the edge.

Consumables
The following items are consumables.
You will need to inform your original dealer or authorized distributor of
the model number of your unit when purchasing the stylus, screen
protective film, and battery pack.
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Stylus
• Purchase a new stylus whenever the tip of your stylus becomes

damaged.

Screen Protective film
• Purchase a new screen protective film when the one on your FIVA

becomes scratched to the point that it makes display contents
difficult to see.

Standard Battery Pack
• Long use of the battery pack causes it to deteriorate and lose its

ability to recharge. If you feel your battery pack is not providing
enough operating time, it may be time to contact your dealer or
authorized distributor about purchasing a new one.

Disposal
When it comes time to dispose of your FIVA, do so in accordance
with local regulations in your area. Contact your local government
authorities for details about proper disposal methods.

Maintenance and Care

Normal Care

Shut down the power and unplug the power cord from the
power outlet before cleaning FIVA. Cleaning FIVA with the
power on creates the danger of electric shock.

• Clean FIVA by wiping it with a soft, dry cloth. If FIVA is very dirty,
wipe it with a cloth that has been moistened with a weak solution of
water and a mild neutral detergent. Wring out all excess of moisture
before wiping. Take particular care to keep the contacts on the
bottom of the FIVA clean. Dirty contacts can lead to malfunction.

• Clean the LCD by wiping it with a soft, dry cloth. Never use water,
detergent, or chemical agents to clean the LCD. The surface of the
LCD is easily scratched. Never apply excess pressure when wiping
it.

• Also, use a soft cloth to clean the tip of the stylus. Take care that
you do not misplace your stylus.

• Thinner, benzene, or other organic agents can cause deformation
or discoloration of FIVA’s case, and even malfunction of FIVA. Never
use such agents when cleaning FIVA.
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• Keep the tip of the stylus free of dirt by wiping it periodically with a
soft cloth. Also take care that you do not misplace or lose the
stylus.

• Clean the FIVA screen by wiping it with a soft, clean cloth. Never
use water, neutral detergents, or chemically treated cloths to clean
the screen. A dirty screen can interfere with response to stylus
operations, and smooth movement of the stylus tip. The screen is
easily scratched, so take care that you do not apply to much
pressure when cleaning it.

Maintenance

Never remove FIVA’S outer cover or otherwise try to take it
apart or modify it in any way. High voltage inside the case
creates the danger of electric shock.

Whenever you notice any of the following symptoms, immediately
shut down the power, unplug the AC adaptor from the power outlet,
and contact your original dealer or authorized distributor.

• Damaged power cord or plug
• Liquid leaking from FIVA
• Exposure of FIVA to water or rain
• Unit being dropped
• Damaged unit cover
• Very abnormal function
• Abnormal operation

Never try to make any adjustments except as specifically instructed
by this User’s Guide. Improper adjustment or modification of FIVA can
permanently damage it and make it impossible to restore normal
operation.

Never attempt to repair or modify this unit in any way.
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The CE marking below applies to the EU region. Declarator of conformity is as follows:

GUIDELINES LAID DOWN BY FCC RULES FOR USE OF THIS UNIT IN THE U.S.A.
(not applicable to other areas.)

NOTICE
This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may
cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to
try to correct the interference by on or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the

receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.
FCC WARNING
Changes or modifications not expressly approved by the party responsible for
compliance could void the user’s authority to operate the equipment.

Declaration of Conformity
Model Number: MPC-501M63E, MPC-501M63O, MPC-501M62E
Trade Name: CASIO
Responsible party: CASIO INC.
Address: 570 Mt. Pleasant Avenue, Dover, New Jersey 07801.
Telephone number: 973-361-5400

This device complies with part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1)This device may not cause harmful interference,
and (2)this device must accept any interference received, including
interference that may cause undesired operation.

CASIO ELECTRONICS CO. LTD.
Unit 6, 1000 North Circular Road, London NW2 7JD
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About This User’s Guide

This User’s Guide is divided into the five sections shown below. Be
sure you read the section titled “Before Using FIVA” starting from
page 8 before you do anything else.

Before Using FIVA
This section provides important safety precautions and things you
need to know to use FIVA correctly.

Chapter 1 Getting Ready
This chapter provides you with general description of functions and
part names. It also explains required procedures for turning power on
and off for the first time.

Chapter 2 Using FIVA
This chapter explains how to turn on power and perform a number of
basic computer operations.

Chapter 3 Supplementary Information
This chapter contains information about how to connect peripherals
and what to do when you experience problems.

Important This mark indicates important cautions and things to which you need
to pay attention when you operate the FIVA.

Note This mark indicates that you need to memorize.

The words “Windows 98” and “Windows” used in this user’s guide simply refer
to the “Microsoft® Windows® 98 Second Edition” operating system.



Chapter 1
Getting Ready
This chapter provides you
with general description
of functions and part
names. It also explains
required procedures for
turning power on and off
for the first time.
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1

Features

The MPC-501 Series is a lightweight and compact pen type
computer.

6.7-inch SVGA (800 × 600) TFT LCD
• High-precision, high-resolution CASIO Hyper Amorphous Silicon

TFT (HAST) LCD
• Thin display design contributes to overall compact and lightweight

configuration.
Highly mobile A5 size
• Compact 870g*, A5 size goes along anywhere.
• Comes with 32MB of memory as standard (96MB maximum) and a

10 or 15GB hard disk built in.
• Two-way power supply operates on batteries or AC for operation

just about anywhere. Power management functions include
standby and hibernation modes

• Built-in Windows 98* lets you take your desktop files along
everywhere.

Versatile Stylus Interface
• Pointing is performed by touching the screen with a stylus.
• Highly efficient handwriting recognition
Versatile Networking
• Use of a LAN card, SS wireless LAN card, or other card provides

quick and easy networking.
• Connection to remote networks using the built-in modem* or

cellular phone data communication card.

* Varies depending on the model. (See page 122)
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Keyboard
Control key and 10-key pad

PC card release lever
Use this lever when removing a PC
card from FIVA.

Microphone

Power switch
Turns FIVA power
on and off.

Monitor
6.7-inch color Hyper Amorphous

Silicon TFT LCD (SVGA)
LCD touch panel screen

Front

Indicator lamps
PW: Power indicator (pages 34 and 90)
BAT: Battery status indicator (page 32)
HDD: Hard disk access lamp (green during access)

Multi-Communication port*1

Connect the cable here for
data communication.

*1 Multi-communication port is not equipped in some models.

Stylus
Use this stylus for touch panel input.
See pages 28 and 41.

Speaker

Hooks
Secure FIVA in place.

The part names introduced in this chapter are used throughout the rest of this User’s
Guide.
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Battery release latch

Operate this latch to
release the battery pack.
(page 31)

Battery pack

RAM module screw
Never touch here.

Reset switch
Pressing this switch with a thin,
pointed object turns off unit power.
Only press this switch when
experiencing operational problems.

PC card slot

Port replicator connector
Connects to the port
replicator

USB connector
For connection of USB
compatible devices.

AC adaptor connector

Back

Cradle Contact
Establishes contact when FIVA
is placed on a cradle.

Infrared port

Control/Shift key
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Key Name

Escape

Delete

Backspace

Tab

Fn

Alternate

Control

Shift

10 keys

Enter (Return)

Decimal point

Hyphen

Space

Cursor

Description

Cancels an operation.

Deletes the character to the right of the
cursor.

Deletes the character to the left of the cursor.

Inputs a tab operation.

Activates certain “hot keys” functions.

Used in combination with other keys to
perform operations and execute commands.

Used in combination with other keys to
perform operations and execute commands.

Shifts the keyboard between upper case
and lower case.

Inputs numbers (0 to 9).

Enters data or inserts a carriage return.

Inputs a decimal point.

Inputs a hyphen or a minus sign.

Inputs a blank space.

Moves the cursor on the screen.

Key
Esc

Del

BS

Tab

Fn

Alt

Ctrl

Shift

~0 9

Enter

.  

–

Spc

Home

PgUp

PgDn

End

Keyboard

This section describes the basic functions of the keyboard.
Actual keyboard functions may differ in accordance with the
application you are using.

• Keyboard keys are grouped according to function: control keys, 10-key pad, and

arrow keys. The Shift  and Ctrl  keys are located on the left side of the FIVA unit.

Function

Control
Keys

10-key Pad

Arrow Keys
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Key

Fn + “1”

Fn + “2”
Fn + “3”

Fn + “4”

Fn + “5”

+ “6”Fn

Fn + “0”

Fn Del Alt+ +
Ctrl Alt Del

Fn + “ . ”

Fn + “–”

Fn Spc+

Fn +

Key Combinations
• Key combinations where you must hold down one key and press a

second are indicated by a plus symbol.
• The following shows the key combinations that are available with

the Fn  key. This is called the “hot keys” function.

CRT* = External monitor

Description

Decreases LCD brightness. (page 84)

Increases LCD brightness. (page 84)

Puts FIVA into Standby Mode. (page 88)

Puts FIVA into Hibernation Mode. (pages 88 and 89)

Decreases speaker sound volume. (page 85)

Increases speaker sound volume. (page 85)

Cycles through monitor function in the following sequence:
LCD(FIVA) → CRT* → CRT* and LCD(FIVA) → LCD(FIVA).

Places a displayed image of the active window onto the clipboard.

Restarts the system without turning off power.

Launches the screen calibration routine. (page 41)

The SOFT KEYBOARD will appear on the FIVA display.

Perform page operations (PgUp, PgDn, Home, End).

Launch previously
defined applications.

For an application to be launched, it
must be compatible with the special
application software. Check with the
producer of the application for details.
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Before Using FIVA for the First Time

Connecting the Neck Strap
Connect the supplied neck to the hook
on the left side of the FIVA unit.

Affixing the Screen Protective Film
The screen protective film protects the display surface from
scratches.
1. Peel the screen protective film from the back surface of the display

protector sheet.
2. Bow the screen protective film in the middle and insert its edges

on either side of the FIVA display.

Pulling out the Stylus
Use your finger to slide the
stylus from its storage slot
on the front of the FIVA unit.
To replace the stylus, slide
it carefully back into the
slot so the raised part of
the stylus enters the slit.

Important • Take care to avoid misplacing the stylus.
• Take care to avoid damaging or breaking the tip of the stylus.
• Keep the tip of the stylus and the FIVA screen clean and free of dirt.

Performing stylus operations when the stylus or screen is dirty can
damage the screen.
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Connecting the AC Adaptor
Connect the AC adaptor to FIVA as shown in the illustration below.
You can connect the AC adaptor with the battery pack in place.
To prevent unnecessary consumption of electrical power, do not
leave the AC adaptor plugged into the power outlet when it is not
connected to FIVA.

Power Supply

This section describes how to set up, remove, and charge the battery
pack.

Attaching and Removing the Battery Pack
Though operation is possible using the AC adaptor only, it is a good
idea to attach the battery pack and charge it before using FIVA for
the first time.

Important Battery packs can also be charged using a separately available
charger unit (MPC-570CHG).

Note
• The supplied battery pack is not charged when you purchase your

FIVA. Note that the battery pack takes about four hours to reach a
full charge, certain condition can cause charging to take even
longer. A battery taking a long time to reach full charge does not
indicate malfunction.

Use only the battery pack that comes with FIVA or a battery
pack specified in this User’s Guide. Use of another type of
battery pack creates the danger of fire.



30

To set the battery pack
1. Turn over the FIVA.
2. Carefully slide the battery pack onto FIVA as shown in the

illustration until you hear it clicks securely into place. If you have
trouble getting the battery pack to connect to FIVA, try sliding the
battery release latch. Do not turn on FIVA yet.

Note
• Pressing the reset switch automatically turns off FIVA power. To

protect against losing unsaved data, make sure that FIVA power is
turned off when you start the above procedure.

• The battery pack discharges naturally even when you do not use
FIVA. Be sure to charge the battery pack before using FIVA for the
first time after a long period of non-use.

Make sure the battery pack is set securely to FIVA. Make sure
you attach the battery pack securely to FIVA. An incorrectly
attached battery pack can fall off, creating the danger of
accident and personal injury.

Battery release latch
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To remove the battery pack
1. Turn over the FIVA.
2. While sliding the battery release latch in the direction indicated in

the illustration below, pull the battery pack from FIVA.

Make sure you have a firm grasp of the battery pack when you
pull it from FIVA. Dropping the battery pack can cause it to fall
on your foot or otherwise cause personal injury.

Charging the Battery Pack
You can use either of the following two methods to charge the battery
pack.

With the battery pack attached to FIVA
The battery pack is charged while the AC adaptor is connected and
plugged into a power outlet, regardless of whether or not the FIVA is
turned on.
Turn off FIVA and charge the battery pack for about two hours.
Turning on FIVA power before full charge is attainted can result in
only a partial charge.
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FIVA’s  lamp lights amber when charging starts, and turns green
when charging is complete. If the  lamp goes out during charging,
it can mean that FIVA’s protection circuit has cancelled the charge
operation. If this happens, remove the battery pack from FIVA and
then reattach it to resume charging. The  lamp going out frequently
during charging indicates malfunction, and you should contact your
original dealer or authorized distributor.

With the special charger unit
See the instructions that come with the charger unit for information
about how to charge the battery pack.

Important • If the battery pack is attached to FIVA, do not unplug the AC
adaptor until the  indicator lamp turns green (full charge). This
helps to extend battery pack life.

• The battery pack requires period replacement. The end of a battery
pack’s service life is indicated when the battery pack powers FIVA
for a relatively short period after a full charge. When this happens,
replace the battery pack with a new one.

• Locate the AC adaptor power cord in a place where it will not be
tripped over.

• Charge the battery pack in an area where the temperature is within
the range of 5°C to 35°C (41°F to 95°F). The battery pack may fail
to reach a full charge at temperatures outside this range. In this
case the   indicator lamp does not light.

• Charging of a battery pack you have not used for a long time may
not start (the BAT-LED does not light amber) when you connect the
AC adaptor. If this happens, leave the battery pack attached and
hold down the RESET switch on the bottom of FIVA for about 10
seconds.

Note
• See page 90 for information about battery pack life and charging

capacity.

Battery Indicator Lamp

Green

Amber

Off at start of charge

Off during charge

Meaning

Full charge

Charging

Charging is disabled. Try charging again in an area
where temperature is within allowable range.

Charge was aborted. Remove battery pack from unit
and check it for external abnormality.
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Turning on Power

To turn on the power
Though it may take a few moments before anything appears on
the display, you do not need to keep the power switch depressed.
Simply press it once and release it.

After waiting for a few minutes, “Welcome” dialogue message
appears followed by “Windows Product Key” dialogue message.
By pushing the Fn  and – keys at the same time the Mobile
Keyboard pops up on the screen. Enter each requested user’s
information by using this keyboard and the 10-key pad.

Important Do not shut down the power once the Windows 98 setup procedure
starts. Also, be sure to power FIVA with its AC adaptor while
performing the setup procedure. After turning power off, wait for at
least 10 seconds before turning it back on again.

The first time you turn on the power, you must perform a Windows 98
setup procedure.
Consult your original detailer for information about the setup
procedure.
You need  to perform this procedure only once. After that, Windows 98
will boot up automatically when you turn on the power.

Note
• The screen goes through a number of changes and may even

flicker while Windows 98 is starting up. This is normal and does not
indicate malfunction of FIVA.

• FIVA’s is equipped with “power management” functions that
automatically go into a low-power standby or hibernation mode if
you do not perform any screen touch or keyboard operation for
about 10* minutes. Input data on the screen when the low-power
Standby or Hibernation is entered is automatically saved, so the
screen reappears on the display when you recover from a low
power mode.
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* You can change the trigger time setting using the Power
Management settings under Mobile Cockpit. See page 79.

• If power does not turn on when you press the power button, see the
troubleshooting guide on page 105.

Shutting Down the Power

Power can be turned off using any of the methods listed below.

• Shutting down Windows 98 from the Start menu.
• Entering the Standby Mode from the Start menu.
• Pressing the power switch. (Enters the Hibernation Mode.)

These methods differ in the amount of power consumed while power
is off and the amount of time it takes before Windows 98 is ready to
be used from any of the power off states.  An understanding of these
differences will help you decide which one you should use.

Shut down Windows from the Start menu or press the power switch to
enter the Hibernation Mode if you do not plan to use FIVA for a long
time (i.e. until the following day).

Mode Storage Time Unit Power  Indicator Lampfor state Recovery Consumption

1Power Off None Long (restart) Almost zero Off

2Standby Memory Fast Yes Flashing

3Hibernation Hard Disk Long Almost zero Off
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To shut down Windows 98 from the Start menu
1. Tap the Start button on the Taskbar.

2. Choose Shut Down....
3. Tap the option button next to “Shut down” and then tap the OK to

shut down the computer.

In this mode, Windows 98 is completely shut down and FIVA is
consuming almost no battery power. This mode extends battery life
but requires that Windows 98 be restarted from the very beginning to
restore power. This means that the status of Windows 98 or any
application that is running is not maintained in memory when the
Power Off Mode is entered. Enter the Power Off Mode if you do not
plan to use FIVA for a long time and before installing expansion
memory.

Choose this option.
To turn power back on again,
press the power switch.

Choose this command.
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To enter the Standby Mode from the Start menu
1. Tap the Start button on the Taskbar.
2. Choose Shut Down....

3. Tap the option button next to “Stand by” and then tap OK to enter
the Standby Mode.

To restore power, press any key or button.

In the Standby Mode, the LCD and other devices are put into a
suspend state. The status of Windows 98 and any applications that
are running is retained in memory, so they can be restored and used
immediately after leaving the Standby Mode. This means that
Windows 98 is restored within the shortest time from this mode, but it
also means that this mode requires more power consumption than
that of the other two modes. The Standby Mode is best when you plan
to be away from the computer for only a short time and need to
immediately pick up from where you last left off when you return.
Tappling the keyboard or other controls on FIVA automatically
recovers from the Standby Mode.

Note
• When you need to leave FIVA on for a long time while using battery

power only, shut down Windows 98 from the Start menu or press
the power switch to enter the Hibernation Mode.

Choose this option.

Choose this command.
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To enter the Hibernation Mode with the power switch
Holding down the power switch for more than one second enters the
Hibernation Mode.

Windows 98 data and data for the application you are using are
written to FIVA’s hard disk. This process takes some time to complete,
after which FIVA powers down automatically after which FIVA enters
the Hibernation Mode, and almost all power is cut off.
Press the power switch again to recover from the Hibernation Mode.
This causes the CASIO logo to appear, followed by the Windows 98
screen that was saved to the hard disk.
The Hibernation Mode is recommended when you do not plan to use
your computer for a long time, but you want to restore the status of
Windows 98 and your applications when you return.

Important • Avoid entering the Hibernation Mode while a communication
operation is in progress, or while a peripheral (disk, printer, etc.) is
in use. Entering the Hibernation Mode while a communication
operation is in progress will cause an error on the other computer.

• The Standby Mode and Hibernation Mode are disabled in the
MS-DOS mode.

• You can reset FIVA and force power to turn off by holding down the
power switch for 10 seconds (until FIVA beeps five times). Note that
FIVA does not beep if sound output is muted. Use this method to
reset FIVA only when operation locks up and nothing else works.



Chapter 2
Using FIVA
This chapter explains how
to turn on power and per-
form a number of basic
computer operations.





41

2

Using the Stylus

Before actually using the stylus to perform screen operations, be sure
to first clean the tip of the stylus and the screen. Performing stylus
operations when the stylus or screen is dirty can damage the screen
and interfere with stylus input.
Use only the stylus that comes with FIVA to perform screen
operations. Never use a pencil, a mechanical pencil, or any other
pointed object. Such objects can damage the display.

When you touch the screen with the stylus, a pointer ( ) appears
on the display to indicate the point you touched. If the pointer
appears at a location that is different from where you touched, use
the procedure described below to calibrate the screen.

To calibrate the screen
1. Open the Taskbar, touch Start, Programs, FIVA TOOLS, and then

Calibration Tool. This causes the calibration screen shown below
to appear, with a cross mark in the upper left corner.
• You can also display the calibration screen by pressing Fn  +

“.”.

2. Tap the cross marks with the stylus in the sequence they appear
on the screen.

3. After you tap the final cross mark, a title bar appears in the title bar
at the bottom of the screen. Use the stylus to draw something on
the screen. Check to make sure line drawn on the screen appears
where you drag the pen on the screen.
• If the line appears in the correct location, press Enter to exit the

calibration procedure.
• Pressing Del deletes the line drawn with the pen and moves the

title bar display up and down.
• If the location of the line is not correct, press 0 and go back to

step 2 of the above procedure.

This bar shifts upward and
downward by each
pressing Del.
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Pen Operations
With FIVA, you can perform all the operations you need by lightly
touching the screen. The following provides descriptions and
examples of a number of basic functions.
1 Double-click
Tap twice on the screen in quick succession to accomplish the same
result as double clicking with a mouse.
2 Drag
Touching an icon causes it to change
colors. Holding the stylus against the icon
and dragging causes the icon to move
along with the stylus.

3 Drag and Drop
Drag and drop lets you move a selected range of text from one
location on the screen to another.

• Touch and hold the beginning of the range of text you want to
select, and drag stylus to the end of the range. Remove the stylus
from the screen when all the text you want is selected. Selected
text is highlighted on the screen as shown above.

• Holding the stylus anywhere inside the highlighted text, drag it to
the location to which you want to move it, and then remove the
stylus from the screen.

4 Right Click
Touch the  icon on the lower right of the screen. The next time you
touch the screen with the stylus performs a right-click operation.

Some applications do not allow right clicking while a range of text is
selected (highlighted).
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Using the Keyboard

Keyboard Types
FIVA Hard Keyboard
The keys to the right of the FIVA display are grouped according to
function: control keys, 10-key pad, and arrow keys. Pressing the
function key Fn  and then another key performs a hot key function.
See page 27 for a complete list of hot key combinations.

Text Input Panel
There are two types of text input panels: Mobile Keyboard and
smARTwriter (a handwriting input panel). The most appropriate
keyboard for the type of operation you are performing appears list,
but you can switch between keyboards at anytime.

• smARTwriter (handwriting input panel)
Use this input panel to input text by hand writing directly on the
screen. smARTwriter cannot be used in combination with the Mobile
Keyboard.

• Mobile Keyboard
Use this keyboard when setting up the system and performing other
input. Press the function keys Fn  and “–” to display the Mobile
Keyboard.
The Mobile Keyboard has the same configuration as a computer
keyboard. You cannot use the Mobile Keyboard and the smARTwriter
at the same time.
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Changing the Mobile Keyboard Size
Touch and hold the lower right corner of the keyboard with the stylus
so the pointer changes from   to . Drag the stylus on the
screen to change the size of the keyboard. Note that the size of the
smARTwriter handwriting input panel cannot be changed.

Moving the Mobile Keyboard on the Screen
Hold and tap the  area on the left side of the keyboard and drag it
to the location you want.
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Inputting Text with the Mobile Keyboard

There are five different Mobile Keyboard configurations. Try them out
and find the one that suits you best. Top change the configuration of
the Mobile Keyboard, tap the  icon in the upper left corner of the
current keyboard, and then select the keyboard you want from the
menu that appears.

1 Full Qwerty key

2 Middle Qwerty key

3 Small Qwerty key

4 ABC key
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5 Ten key
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Using handwriting input (smARTwriter)

FIVA comes with smARTwriter handwriting recognition software. You
can find detailed information about all of the features and functions in
the online help that is available while smARTwriter is running. The
following explains of smARTwriter Plus Ver.3.5.
smARTwriter is a pre-installed handwriting recognition application that
lets you input text into an active application, launch applications,
open documents and more by writing with the stylus directly on the
FIVA screen.
Writing on any part of the FIVA screen creates “electronic ink,” which
is then recognized and interpreted by smARTwriter. Finally, the results
are sent to the active application as if they were typed using a
keyboard.

How does it work?
“Electronic ink” appears as you write on the FIVA screen. When a
timeout occurs (when you lift the pen for a certain time interval),
smARTwriter passes the recognized output to the active application.
The recognition process is performed by comparing the symbols you
write against a set of defined smARTwriter symbols. This set of
symbols is called a Library. The Library contains shapes of letters,
digits, punctuation marks, etc.
The Library can contain more than one version of a letter or symbol.
The letter “G,” for example may be written as shown below:

smARTwriter has a generic library containing common handwriting
styles for characters, so your handwriting probably will be easily
recognized the first time you use smARTwriter.

Training smARTwriter
Training lets you teach smARTwriter your own handwriting style,
which improves the recognition rate. You can train smARTwriter using
any of the methods listed below.
• Quick Trainer. This is an automatic tool for adding letter models to

the Library (page 48).
• On-the-spot training. You can correct a recognition error whenever

one occurs.
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Achieving Good Recognition
Following the tips listed below helps to improve the handwriting
recognition rate.
• Write without stopping. There is no need to wait for smARTwriter to

recognize text.
• Write using printed (not connected or cursive) characters.
• Do not use delayed strokes. Dot your “i” and cross “t” characters

immediately.
• Avoid touching the screen with your hand while writing. Doing so

can leave unwanted ink on the screen.
• Avoid writing small characters. Doing so can cause loss of

resolution and character recognition errors.
• After using smARTwriter for a few days, we recommended that you

edit the Library and delete any redundant or incorrect models. See
“Library” on page 60 for more information.

Using Quick Trainer
Quick Trainer is an application you can use to teach smARTwriter
your particular style of writing, which helps to improve recognition
results. It takes less than five minutes to complete one Quick Trainer
session.

To run Quick Trainer
1. Start up Quick Trainer by selecting: Start → Programs →

smARTwriter for Windows → Quick Trainer.
2. A prompt appears asking if you want to train Western European

characters.
• If you want to train using standard English characters, tap No and

then tap OK.
• If you want to train using other (non-standard English) characters,

tap Yes and then select the language from the pull down menu on
the right. Next, tap OK.
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3. The Quick Trainer window appears, showing a passage of text.

4. Copy each character into the slot or box directly under it, one
character in each slot. If you make a mistake, re-write the letter or
character. You can re-write a letter or character as many times as
you need. Make sure you write characters in all the slots provided.
Letters that smARTwriter immediately recognizes will be
highlighted. The rest will be learned by the recognition system
when you tap the Accept button.
The bar at the bottom of the window indicates the progress of the
session.

5. After you finish writing all the characters, tap the Accept button. If
you want to clear the screen and start over, tap the Clear button.

Note
• You can repeat Quick Trainer sessions as often as you want.

Repeating sessions improves recognition results even more.

Using the Euro Trainer
Using the Euro Trainer, you can train smARTwriter to recognize your
handwriting in Western European languages other than English.
To launch training for non-English Western European characters,
select Start → Programs → smARTwriter for Windows → Euro
Trainer.
A prompt asks you to choose a Western European language. Select a
language, and tap OK. Then follow the instructions described above
in Using the Quick Trainer.
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Using smARTwriter
This section explains what you need to know in order to actually set
up and use smARTwriter on your FIVA.

Starting Up smARTwriter
smARTwriter always starts up automatically every time you turn on
FIVA. You can, however, quit smARTwriter manually (selecting Exit
from the smARTwriter menu option), and then start it back up
manually the next time you want to use it.

To start up smARTwriter manually
1. On your FIVA, select: Start → Programs → smARTwriter for

Windows, and then tap the smARTwriter shortcut icon.
2. The above step causes the smARTwriter control icon to appear in

the icon tray in the bottom right corner of the screen. This indicates
that smARTwriter is active.

smARTwriter Modes
You can control pen operations and handwriting recognition using the
smARTwriter icon in the bottom right corner of the screen.

The shape of the icon indicates the current mode.
• Pointing Mode ( )
This icon indicates that the stylus operates as a pointing or selection
device.
• Writing Mode ( )
This mode indicates that the stylus operates as a writing device.
Tapping the icon toggles between the modes.
Double-tapping the icon or holding down the Alt key and tapping the
icon, opens the smARTwriter menu.

smARTwriter tray icon
(Writing Mode)
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• Pen-Aware mode ( )
This is an automatic mode used by applications with several input
fields. Pen-aware applications (such as ART’s Quick Trainer) switch
back and forth between the Writing and Pointing modes according to
the pen’s position on the screen.

First Steps in Writing with smARTwriter
1. Switch to Pointing Mode( ) and then start up an application, such

as Word.
2. Switch to Writing Mode ( ) and tap in the input area of the

application so the insertion cursor appears. You are ready to start
writing on the screen.

3. Using the stylus, write a few words in the Pocket Word document
area. Write continuously. It is not necessary to pause after each
letter. smARTwriter reads the “ink,” recognizes it, and converts it
into printed text.

4. The recognized text appears at the insertion point.

Note
• Recognized text is always inserted to the left of the cursor in the

active window.
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Using Gestures
A “gesture” is a symbol you draw to activate a special function or
enter a special character, like a backspace, new line, etc.
The following are the gestures available with smARTwriter.

Note
• The heavy dot indicates the starting point of each gesture.

For example, the following describes the steps you should perform
when you want to use the Backspace gesture.
1. Switch to the Writing Mode ( ).
2. Draw the Backspace gesture on the screen.
3. This causes the character to the left of the cursor position to be

deleted.

Activating the Correction Box
The Correction Box is a built-in tool that makes it easy to correct
misrecognized text. You can use any of the three different procedures
to activate the Correction Box.

To activate the Correction Box with the Correction gesture
1. Write until a recognition error occurs.
2. Draw the Correction gesture over the word you want to correct.

• This selects the word and activates the Correction Box with the
misrecognized word inside it.

Correction

Backspace Space New Line

Edit Selected Edit Selected Tab

Training Backspace
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To activate the Correction Box with the menu
1. Write until a recognition error occurs.
2. Select (highlight) the misrecognized word.
3. Tap the smARTwriter icon and then select Correct... from the

smARTwriter menu.
• This activates the Correction Box with the misrecognized word

inside it.
To activate the Correction Box with an Edit Selected gesture
1. Write until a recognition error occurs.
2. Select (highlight) the misrecognized word.
3. Draw either of the Edit Selected gestures.

• This activates the Correction Box with the misrecognized word
inside it.

Using the Correction Box
The Correction Box displays the characters that make up the
selected word with a down arrow underneath each one.

To make corrections
1. Tap the down arrow under the character you want to change. This

displays a menu of other possibilities for the character.
2. Choose the character you want by tapping it. You can also change

a character by writing the new character directly into the box or
slot on the Correction box.

Note
• The menu that appears when you tap a down button also contains

two commands. Tapping Ins inserts a space in front of the current
character, while Del deletes the current character or space.

3. Tap the Replace button to replace the original word with your
corrected version. To delete the word from your input, tap the
Delete button.
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The smARTwriter Menu
Tapping the smARTwriter icon opens the smARTwriter menu, which
provides access to the main functions of smARTwriter.

Correct
Activates the Correction Box. See “Using the Correction Box” on
page 53.

Train
Opens the Trainer dialog box so you can “teach” smARTwriter your
handwriting style. See “Training smARTwriter” on page 47.

Library
Opens the Library Manager. See “Library Models” on page 61.

Properties
Displays the smARTwriter Properties dialog box. See “Properties” on
page 63.

Help
Displays smARTwriter online help or copyright and version
information.

Exit
Tap here when you want to manually shutdown smARTwriter.

Pen mode
Toggles between the smARTwriter Writing mode ( ) and Pointing
mode ( ). See “smARTwriter Modes” on page 50.

Tap here.
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Train
You can train smARTwriter to recognize your own individual
handwriting style for characters, strings, macros, gestures, or
application shortcuts.

Note
• Training improves the handwriting recognition rate because it

teaches smARTwriter how to recognize your particular writing style.
See “Using Quick Trainer” on page 48 for information about how to
use another training tool named Quick Trainer.

To access training while you are inputting text, tap the smARTwriter
icon in the icon tray, select Train from the smARTwriter Menu, and
then select one of the training options: Character...,
Macros and Gestures..., or Application Shortcuts....

Character
This option opens the Trainer dialog box. You can also draw the
gesture shown below to open the Trainer dialog box.

When the Trainer dialog box opens, it shows the last ink pattern you
wrote or selected. Use this dialog box to teach smARTwriter to
interpret the pattern (or a part of it) as a single character.

To teach smARTwriter a character
1. Display the Trainer dialog box by tapping the smARTwriter icon and

then selecting Train → Character....
• The last ink pattern you drew is shown in the upper part of the

Trainer dialog box.
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2. In the upper part of the Trainer dialog box, select the segments or
parts of the ink pattern that you want to use as a character.

Note
• Tap the ink pattern to select it, tap it again to deselect. If there is

more than one stroke, make sure you select all the strokes that are
part of the character. The strokes you select appear in the Trainer
dialog box, which shows the ink pattern that will be used for
recognition.

3. Tap the down arrow next to the As box and select the character
from the list that appears.

• If you cannot find the character you want in the list, select Other.
See “Other Symbols” below.

• You can also use the stylus to write the text character you want
directly into the As box.

• No matter how you specify a character, the character in the As box
will be associated with the ink pattern in the Trainer dialog box.

4. Tap the Train button to train the character and save your changes
to the Library of Models.

5. Tap the close box  to close the Trainer dialog box.

Other Symbols
If the character you want is not in the list, select Other from the list to
open the Train Symbol dialog box.

The Train Symbol dialog box provides a selection of non-standard
and international symbols. Tap the character you want on the Train
Symbol dialog box to select it, and then tap OK.
The following functions are also available on the Trainer dialog box.
• Tap the Undo button if you made a mistake and want to “untrain”

the character.
• Tap the Macro button when you want to train the selected ink

pattern as a character string, macro, or gesture. Tapping Macro
displays the Train Macro Wizard, which shows the selected ink
pattern. See “Macros & Gestures” on page 57 for more information
about this dialog box.
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Note
• If you open the Trainer dialog box while text is selected in a

document, the selected text is automatically replaced by the newly
trained character when you close the Trainer dialog box.

Macros & Gestures
This option opens the Train Macro Wizard dialog box with the last ink
pattern you wrote or selected. Use this dialog box to teach
smARTwriter to interpret the pattern as a character string, macro, or
gesture.

To teach smARTwriter a character string, macro, or gesture
1. Display the Train Macro Wizard dialog box by tapping the

smARTwriter icon and then selecting Train → Macros & Gestures.
• The last ink pattern you drew is shown in the Draw Macro Ink box.

• You can use this pattern as it is, or you can replace it with another
pattern by tapping the Clear Ink button and then drawing another
ink pattern.

2. When the ink pattern is the way you want, tap the Next button to
continue.

• To cancel training, tap the Cancel button.
3. In response to the prompt that appears, tap New Macro if you are

creating a new macro, or Existing Macro or Gesture to associate
the ink pattern with an existing macro. Next, tap Next to continue.

What happens next depend on whether you selected New Macro or
Existing Macro or Gesture in step 3 of the above procedure.

New Macro
1. In response to the prompt that appears, use the stylus to enter a

name for the macro or gesture. The name you enter appears in the
Enter Macro Name box. After you are finished, tap Next to
continue.

2. Use the stylus to enter the macro sequence or character string.
• Characters are displayed as characters.
• Functions are displayed as the functions they represent. For

example, a tab operation appears as <TAB>.
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3. Tap Finish to save the macro and close the Train Macro Wizard.

Existing Macro
1. On the dialog box that appears, select the macro or gesture you

want from the list.

• The lower part of the dialog box shows the sequence currently
assigned to the selected macro or gesture.

2. Tap the Finish button to save your changes and close the Train
Macro Wizard.

Application Shortcuts
This option opens the Train Shortcut Wizard dialog box with the last
ink pattern you wrote or selected. Use this dialog box to teach
smARTwriter to interpret the pattern as a shortcut to launch an
application.

To teach smARTwriter an application shortcut
1. Display the Train Macro Wizard dialog box by tapping the

smARTwriter icon and then selecting Train → Application
Shortcuts.

• The last ink pattern you drew is shown in the Draw Macro Ink box.

• You can use this pattern as it is, or you can replace it with another
pattern by tapping the Clear Ink button and then drawing another
ink pattern.

2. When the ink pattern is the way you want, tap the Next button to
continue.

• To cancel training, tap the Cancel button.
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3. In response to the prompt that appears, tap New Shortcut if you
are creating a new shortcut, or Existing Shortcuts to associate
the ink pattern with an existing shortcut. Next, tap Next to
continue.

Note
• The prompt described in step 3 appears only when one or more

application shortcut already exists. If there are no application
shortcuts yet, the New Shortcut option is selected automatically.
What happens next depend on whether you selected New
Shortcut or Existing Shortcuts in step 3 of the above procedure.

New Shortcut
1. Tap the Browse button. On the dialog box that appears, select the

application for which you want to create a shortcut and then tap
OK.

2. The path to the application you selected appears in the Shortcut
command line box, and the name of the application appears in
the Shortcut name box.

3. Tap Finish to save the shortcut and close the Train Shortcut
Wizard.

Existing Shortcuts
1. On the dialog box that appears, select the shortcut you want from

the list.

• The lower part of the dialog box shows the path to the application
currently assigned to the selected shortcut.

2. Tap the Finish button to save your changes and close the Train
Shortcut Wizard.
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Library
The collection of characters and shapes recognized by smARTwriter
is called the Library of Models. smARTwriter contains a pre-defined
Library of Models with over 371 distinct characters.
smARTwriter recognizes handwriting primarily by comparing the
shape and direction of flow of individual characters you write to a set
of character shapes (models) stored in the Library of Models. Every
time you train smARTwriter, you add character models to the Library
of Models. To improve recognition, you should periodically use
Library Manager to delete redundant or unnecessary models from the
library.

Library Manager
Library Manager lets you maintain the list of character shapes and
symbols in a specific Library of Models. This is especially useful if
your FIVA is used by more than one person. You can create a Library
of Models for each user, so smARTwriter can recognize each
individual’s personal handwriting style.

To open Library Manager
Tap the smARTwriter icon and then select Library... from the menu.

Library Name
This is the name of the currently active library. It also shows the total
number of models in the library. Normally, the Library Name is the
same as the user name.

Library Name

Type of Models

Library Models
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To view: Select:

All characters in the Library of Models All

Lower case characters only Lower

Upper case characters only Upper

Numbers only Digits

Symbols and punctuation marks only Punc.

Gestures only Gestures

Macros only Macros

Shortcuts only Shortcuts

Type of Models
Use this box to specify the category of models you want to view. Tap
the down arrow and select one of the categories listed below.

You cannot use this box to view macros and shortcuts.

Library Models
This box lists all the characters, gestures, macros, and shortcuts in
the library. It lets you select a specific character and review its
associated models. To view the models associated with a specific
character, select a category from Type of Models list. Then tap a
character in the Library Models list. The database of models for the
character you select appears in the Models Box.

Models Box
This box shows the models assigned to character. The total number
of models assigned to the selected character is shown above the
Models Box.
Use the scroll bar to view the different character models assigned to
the selected character. The leftmost model is the last model assigned
to the character.
To select a model, tap it once.

Delete Button

Note
• This button is dimmed (unavailable) unless a macro or a shortcut

model is selected in the Models Box.

Tap this button to delete the selected model from the library.

Libraries Button
Tap this button to display the Libraries Window.
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Using the Libraries Window
Use the Libraries Window to create new libraries, open an existing
library (change the active library), and to copy and delete libraries.
The icons on the top of the Libraries Window represent New (create),
Open (change), Copy, and Delete.

Creating a New Library
If more than one person uses the FIVA, it is a good idea if each user
creates a personal Library of Models.

To create a new library
1. Tap the New button ( ).
2. In response to the prompt that appears, enter the name you want

to give the new library, and then tap OK.
• Normally, you should use the name of the user as the name of the

library.
3. On the New Library dialog box that appears on the display, select

one of the followings as the type of Library you want to create.

4. Tap OK

Note
• Whenever you create a minimal library, smARTwriter automatically

launches Quick Trainer. See “Using Quick Trainer” on page 48.

To open an existing library and change the active library
1. On the Libraries Window, select the library you want to open from

the list of libraries.
2. Tap the Open button ( ).

To copy a library and save it under a different name
1. On the Libraries Window, select the library you want to copy from

the list of libraries.
2. Tap the Copy button ( ) to display the Copy Library dialog box.
3. Enter the name you want to assign to the copy of the library.
4. Tap the OK button to save the copy.

When you want to:

Load the standard smARTwriter library, with
the full range of default model samples

Load all punctuation marks and predefined
gestures and shortcuts only.
• This case, you must train smARTwriter to

recognize your handwriting style. See
“Training smARTwriter” on page 47, and
“Using Quick Trainer” on page 48.

Select:

Standard default
lilbrary.

Minimal lilbrary.
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To delete a library

Note
• Make sure that the library you are deleting is not the active library. If

it is, change the active library.
1. On the Libraries Window, select the library you want to delete from

the list of libraries.
2. Tap the Delete button ( ).

Properties
This menu option displays a dialog box for setting the properties of
smARTwriter. The Properties dialog box contains the following tabs.

General
This tab contains settings for customizing smARTwriter behavior.

Timeout
Sets the time smARTwriter waits from the moment you lift the pen from
the screen before it begins recognition of the “ink” pattern. The range
is from 0.1 to 1.5 seconds.

Enhanced recognition of English
Checking this box enables the smARTwriter linguistic layer, which
allows smARTwriter to recognize rules and guidelines for the English
language. For example, if the “g” in “reading” is written very similar to
a “y,” the linguistic layer knows that “iny” is not a common ending in
English and that “ing” is a more probable combination. Therefore,
smARTwriter outputs “reading” as the recognized word.
Enhanced Recognition of English is checked by default. You should
disable this option if you are not writing standard or plain English text.

Space after recognition
When this option is checked, smARTwriter adds a space after each
set of characters recognized (after each timeout).

Enable Sounds
When this option is checked, smARTwriter plays error and warning
sounds through the FIVA’s speaker.
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Ink
The settings on this tab control the way the electronic ink is displayed
on the FIVA screen.

Ink Width
Use this setting to change the width of the ink. Tap the up or down
arrow to change the width within the range of 1 to 5 points.

Ink Color
This area shows a sample of the color currently selected for the ink,
and provides a button for changing the color.

To change the color of the ink
1. Tap the Change... button to display the Color dialog box, which is

a standard Windows color palette.

2. Select the color you want to use for the electronic ink.

Note
• Refer to your Windows documentation for more information about

using this dialog box.
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Orientation

Note
• This option affects smARTwriter only. The screen orientation of your

other applications does not change.
These settings let you adjust the position of the screen for use as a
writing board. They define the writing orientation so smARTwriter can
recognize the electronic ink pattern.

Ink Filter
Use these settings to correct ink patterns and help improve
recognition.
• Smooth out jagged ink
Check this option to eliminate “dotting” and make electronic ink
appear smooth. For optimal recognition, make sure that this setting is
the same for both writing and training sessions.
• Eliminate random ink spikes
Check this option to remove sharp ink edges, making the edges of
the electronic ink appear rounded. For optimal recognition, make sure
that this setting is the same for both writing and training sessions.

Hot Key
Use this tab to create a hot key or shortcut that toggles between the
Writing Mode ( ) and Pointing Mode ( ). You can tap a radio button
to select a predefined hot key, or select Other to define your own
shortcut. When you specify one of the Ctrl and Shift options, the
toggle is performed after you press and release the applicable key.
• You cannot select Right Shift and Right Ctrl options with FIVA

MPC-501.
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Constraints
This tab lets you turn recognition filters on and off. Turning on filters
helps to improve recognition.
As explained previously, smARTwriter searches through a large
number of symbols in the Library of Models to find a match for each
character you write. If you are inputting only characters from a certain
group (lower case, numerals, etc.), you can constrain (limit) the
search to those character groups and minimize recognition errors.
To constrain the search, uncheck the character set(s) you are not
using. You may check or uncheck any combination of sets to fit your
writing style.

Note
• For every recognition operation, smARTwriter searches through all

the character sets that are checked  on the Constraints tab.

The following is an example of using Constraints.
1. Tap the smARTwriter icon in the icon tray and select Properties....

Next, display the Constraints tab.

2. On the Constraints tab, uncheck all sets except Lowercase and
then tap OK.

• Now anything you write will be interpreted as lower case letters.

Quitting smARTwriter
Use the following procedure to manually quit smARTwriter when
necessary.

To quit smARTwriter
1. Tap the smARTwriter icon in the icon tray.
2. Select Exit from the Menu.
3. On the confirmation dialog box confirming whether you want to quit

smARTwriter, tap Yes.
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Using smARTscribble

Basic Concepts

About smARTscribble
smARTscribble is a sketching application you can use to draw on the
screen and capture the ink pattern. The resulting image is a set of
stylus strokes you can edit later. smARTscribble also lets you add text
to the image.
The following are just some of the ways you can use smARTscribble.
• Taking handwritten notes - instantly put your ideas in writing.
• Drawing images, sketches, road maps, etc. with explanatory text.
• Combining any part of the ink or text with other Windows

applications such as Microsoft Word.

Starting Up smARTscribble
Select Start → Programs → smARTwriter for Windows and then
tap the smARTscribble shortcut icon.

Working with Images

To draw an image
Simply use the stylus to draw on the screen of the FIVA as if you were
drawing on paper.

To edit an image
Use standard Windows editing procedures to edit images with
smARTscribble. In other words, select the image and then edit it
using Cut, Copy, Paste or Delete. You can access editing features
by selecting them on the smARTscribble Edit menu or by using
keyboard shortcuts.
You can also use the editing features of smARTscribble to paste
images copied or cut from one document into another document.

Selecting Images

To select a single image
1. Tap the Selection Boundary button ( ) on the smARTscribble tool

bar. The button remains pressed until the selection procedure is
complete.

2. Drag the stylus diagonally across the area containing the image
you want to select. A selection boundary appears on the screen
where you drag the stylus.
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3. Lift the stylus from the screen. All the strokes contained within the
selection boundary become highlighted. Strokes that are partially
within the selection boundary are also highlighted.

Note
• Selecting as area or image automatically cancels  any previous

selection on the screen.

To select all the images on the screen
On the Edit menu, tap Select All.

To delete an image
Select the image and then tap the Delete button ( ).

To cut an image
Select the image and then tap the Cut button ( ). This deletes the
image from the screen and places it onto the clipboard.

To copy an image
Select the image and then tap the Copy button ( ). This places a
copy of the image onto the clipboard without affecting the original
image.

Note
• Copied images can be pasted into documents created with other

applications, such as Word.

To paste an image from the clipboard
1. Tap the Paste button ( ).
2. Drag the pasted image (which is surrounded by a selection

boundary) to the location you want it.
3. Tap anywhere outside the selection boundary to deselect the

pasted image.

To move an image
1. Select the image.
2. Drag the image to its new location with the stylus.

Working with Text
With smARTscribble, you can add text anywhere in a smARTscribble
document. Each text line you enter is considered a separate object
containing a single line of text.

To add new text
1. Tap the Text button ( ) to switch to the text mode.
2. Tap the location in the document where you want to place the new

text, and a text box appears on the screen.
3. Enter text into the text box.
4. After you are finished, tap anywhere outside the text box or tap the

Text button again to finish entering text.
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To modify existing text
1. Tap the Text button ( ) to switch to the text mode.
2. Tap the text item you want to edit.
3. Make any changes you want.
4. After you are finished, tap anywhere outside the text box or tap the

Text button again to finish entering text.

Editing Text
Use standard Windows editing procedures to edit text with
smARTscribble. In other words, select the text and then edit it using
Cut, Copy, Paste or Delete. You can access editing features by
selecting them on the smARTscribble Edit menu or by using keyboard
shortcuts.

To select text
• To select a whole word, double-tap the word.
• To select a string of consecutive letters or words, drag the stylus

across the text you want to select.

To delete text
Select the text and then tap the Delete button ( ).

To cut text
Select the text and then tap the Cut button ( ). This deletes the text
from the screen and places it onto the clipboard.

To copy text
Select the text and then tap the Copy button ( ). This places a copy
of the text onto the clipboard without affecting the original text.

Note
• Copied text can be pasted into documents created with other

applications, such as Word.

To paste an image from the clipboard
Open the text box where you want to paste the text and then tap the
Paste button ( ).

Note
• Text copied from other applications can be pasted into a

smARTscribble text box.

To insert the date and time into a page
On the File menu, tap Time Stamp to paste the date and time into the
upper right corner of the active page.
To remove the date and time, deselect the Time Stamp option on the
File menu.
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Ink

Changing the Ink color

To change the color of the ink
1. On the Edit menu, tap Pen Color to display the Color dialog box,

which is a standard Windows color palette.

2. Select the color you want to use for the ink.

Note
• For more information about using this dialog box, refer to your

Windows documentation.

Changing the Ink width
smARTscribble supports three ink widths: thin, medium and thick. The
currently selected width is always shown on the toolbar in the Ink
Width box.

To change the ink width
1. Tap the Ink Width down arrow.

2. This displays the three available width options. Tap the width you
want to select it.
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smARTscribble Documents

Creating, Saving and Opening Documents
smARTscribble documents can be saved as files.

Note
• smARTscribble document files have names that end with the

extension INK. Any file with this extension is automatically
associated with smARTscribble.

• To create a new smARTscribble document, tap New on the File
menu.

• To save a smARTscribble document under its current name, tap
Save on the File menu.

• To save a smARTscribble document under a different name, tap
Save As on the File menu.

• To open an existing smARTscribble document, tap Open on the File
menu.

• To save the current page in bitmap format (that you can print),
select Export Page as Bitmap on the File menu.

Navigating Around a Document
A smARTscribble document can have up to 20 pages of ink (images)
and text. To scroll through the pages of a document, tap the  or 
button. The number between the buttons indicates the current
document page number.

Guidelines
smARTscribble lets you display guidelines to help you align your
images and text. You can select either gridlines or horizontal lines.

To show guidelines
On the View menu, tap either of the followings
• Grid: Displays a grid of dashed guides.
• Lines: Displays thin horizontal guides.

To hide guidelines
On the View menu, tap the currently selected guideline style (Grid or
Lines) to deselect it.
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Page Size
Each new smARTscribble document page is sized to fit the FIVA
screen. Use the Expand ( ) to expand the size of the document
page.
• To lengthen the size of a page, tap the Expand ( ) button.
This causes the page to expand downwards. You can view the area
of the page off the bottom of the screen by using the vertical scrollbar
on the right of the page.

Note
• When you switch between pages, smARTscribble automatically

adjusts the page size so all the data fits on the page.

Previewing a Document

To preview the current page:
1. On the View menu, select Page Preview.
• This displays the Page Preview window, which shows the contents

of the entire page.
2. To close the Page Preview window, tap the Close button.
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Using Mobile Cockpit

Your FIVA comes with Mobile Cockpit pre-installed, an original CASIO
application that makes operation quicker and easier. To start up
Mobile Cockpit, tap the  on the Task Bar.
Mobile Cockpit can be displayed as a toolbar along the top of the
display, which gives you quick and easy one-touch access to its
functions.

System Management Toolbar

21 4 93 567 8 0 q we r

Name

Toolbar Switch

System Tool
Startup

Mobile Cockpit
Settings

Power Management
Settings

LCD Brightness

CPU Clock Speed

Sound Volume

Hardware Power
Management

Show Properties

Battery Report

Battery Status

Standby Mode

Hibernation Mode

Help

No.

1

2

3

4

5

6

7

8

9

0

q

w

e

r

Description

Tap these buttons to switch between the
System Management Toolbar and the
Application Startup Toolbar.

Tap this button to access Power Management
Tools and BIOS Tools.

Right-tap here to display a menu for
controlling icon size, hiding of the toolbar, etc.

Tap these buttons to switch between Economy,
Normal, and User Defined Modes.

Tap this button to display a slider that controls
display brightness.

Tap this button to display a slider that controls
CPU Clock Speed.

Tap this button to display a slider that controls
speaker volume.

Tap these buttons to cut off power to the hard
disk, USB, multi-communication port.

Tap these buttons to display the properties of
the infrared port or PC card.

Tap this button to display the battery report.

Tap this button to display the current battery
status.

Tap this button to enter the Standby Mode.

Tap this button to enter the Hibernation Mode.

Tap this button to display on-line help.
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11111 Toolbar Switch

There are two different Mobile Cockpit toolbars, a System
Management toolbar and an Application Startup Toolbar. Only one of
these toolbars can be displayed at any time. Tapping the Toolbar
Switch toggles between the System Management toolbar and
Application Startup Toolbar.

• System Management Toolbar
This toolbar makes it easy to set up the FIVA operating environment.
Tapping an icon displays a setup dialog box, which you can use to
make settings as indicated on the screen.

• Application Startup Toolbar
Once you assign an application to the Application Startup Toolbar,
you can start it up by simply tapping its icon. Use this toolbar for easy
access to your frequently used applications.

About the Application Startup Toolbar
Tap the Toolbar Switch to display the Application Startup Toolbar.

Assigning an Application to the Application Toolbar

To assign an application to the Application Toolbar from the
Start menu
On the Windows 98 Taskbar, tap Start, point to Programs, and drag
the application you want from the Start menu and drop it on the
Application Toolbar.

Drag and drop
any applications.
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To assign an application to the Application Toolbar from the
My Computer folder
Drag the application you want from the Windows 98 My Computer
folder and drop it on the Application Toolbar.

To launch an application from the Application Toolbar
Tap the icon of an application to launch it.

To remove an application from the Application Toolbar
Right-tap the icon of the application you want to remove (page 42).

Note
The above procedure simply removes the application’s icon from the
Application Toolbar. It does not uninstall the application.

22222 Starting Up a System Tool

Tap the  icon on the System Management Toolbar. On the dialog
box that appears, start up either Power Management Setup Tool or
BIOS Startup Tool.
See “4 Making Power Management Settings” on page 81 for
information about using Power Management Setup Tool.
Starting up BIOS Startup Tool displays the BIOS Settings dialog box.

Drag and drop the application.

Right-tap the applications’s icon.
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Displaying Current BIOS Settings
Mobile Cockpit lets you view the BIOS settings of your FIVA, and even
make certain changes to them. Though the BIOS settings of FIVA are
set to their optimal values at the factory, there may be special
occasions when you need to change them.

Important • When you are unable to start up in the Safe Mode correctly for
some reason, execute setup default from the BIOS Set UP UTILITY
by holding down Del key while FIVA is starting up. Start up may be
impossible if BIOS settings are not correct.

Note
“BIOS” stands for Basic Input/Output System, which is the name of
software that controls certain basic functions of your system.

Tap the Mobile Cockpit Tools icon.

To display BIOS settings
Use the following procedure to check current BIOS settings.
On the menu that appears, click BIOS Setup Tool.

Tap here.

Select this item.
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Changing BIOS Settings
The following procedures can be used to change certain BIOS
settings. The following describes the BIOS settings you can change
and when you should change them.

• CD-ROM Startup
Whenever you want to use the “Product Recovery CD-ROM” to
restore the hard disk drive to its initial factory setup, you need to
first change the BIOS settings to allow startup from the CD-ROM.

• Replicator COM Port Settings
COM Port 1 normally is assigned as the Multi-Communication Port.
Do not change these settings.

1) To specify CD-ROM startup
To use the “Product Recovery CD-ROM” to return hard disk settings
to their initial factory defaults, you must first change the BIOS settings
to enable system startup from the connected CD-ROM drive.

On the BIOS Settings screen, tap the Boot tab.

Check the checkbox next to “PCMCIA”.
Tap the OK button.

Now FIVA, it will start up from the CD-ROM.

Check this item.
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2) To change replicator COM port settings
The factory default setting for the COM1 Port setting of a model
equipped with a built-in modem is “Multi-Communication Port.” When
using FIVA with an optionally available port replicator, you must
change the COM1 Port setting to “Port Replicator” before connecting
a peripheral device to the replicator’s serial port.

On the BIOS Settings screen, tap the COM Port tab.
Under COM Port 1, tap the selection button next to “Port Replicator”.
To use the built-in modem, you must first change the COM1 Port
setting back to “Multi-Communication Port.”

Tap the OK button.

3) Password Settings
You can register a password up to eight characters long to keep
others away from using FIVA. Once you register a password, a
prompt for password input will appear any time you turn on power or
return to Windows 98 from the Hibernation Mode. In such cases, FIVA
cannot be used until the correct password is input.

Important • If you forget your password, you will no longer be able to startup
FIVA. Make sure you keep a separate record of the password or
that you use a password you can remember easily.

Check this item.
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On the BIOS Settings screen, tap the Security tab.
You can specify separate passwords for User and Supervisor.

Check the checkbox next to “Request password at startup”.
Tap the OK button.

33333 Making Mobile Cockpit Settings

Right-tap on the MOBILE COCKPIT logo to display a menu of settings
that control the size of buttons, and more. You can also display the
Mobile Cockpit menu by clicking the Mobile Cockpit icon on the
Toolbar.

Check this item.

Type in a password.

Right-tap here.
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The following describes the settings you can make with the Mobile
Cockpit menu.

Tap the Mobile Cockpit icon.

Menu Item

Auto hide

Hide

Keep on top

Large Buttons

Help Topics

About Mobile Cockpit

Close

Description

Select this option when you want the Mobile Cockpit
toolbar to hide automatically when it is not in use. The
toolbar reappears automatically whenever you move
the mouse pointer to the top of the display.

Select this option when you want to keep the Mobile
Cockpit toolbar hidden. To make it reappear, tap the
Mobile Cockpit icon on the toolbar, and then select
Hide again.

Select this option when you want the Mobile Cockpit to
always be on top of the windows currently on the display.

Select this option to increase the size of the buttons
that appear in the toolbar.

Tap this button to display on-line help about Mobile
Cockpit.

Tap this button to display Mobile Cockpit version
information.

Tap this button to exit Mobile Cockpit.



81

2

Normal Mode Economy Mode Power Management Off
CPU Clock Speed 100% 50% 100%
Hard Disk Power Off 5 minutes 1 minute No power off
LCD Brightness 90% 50% 100%
Time to Standby 10 minutes 2 minutes No standby
Time to Hibernation 10 minutes 5 minutes No Hibernation

44444 Making Power Management Settings

Power Management lets you control the amount of power supplied to
the CPU, LCD, hard disk, and other peripherals in order to extend
battery life. The followings are the available Power Management
modes.

• Economy Mode
• Normal Mode
• User Defined Mode

The User Defined Mode lets you specify a number of Power
Management parameters, including those listed below.
• Amount of time to allow after the last operation before the system

goes into the Standby Mode
• Method for alerting the user to low battery power
• CPU Clock Speed
• LCD Brightness

To change the Power Management Mode

Tapping the Economy Mode, Normal Mode, or User Defined Mode
button changes to the corresponding mode. The following shows the
settings that are made when the Economy Mode or Normal Mode is
entered.

Note
Power Management is turned off automatically whenever the AC
adaptor is connected to FIVA.

Normal Mode Economy Mode

Power Management Off User Defined Mode
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To make user settings
1. Tap the Mobile Cockpit Tools icon.

2. On the menu that appears, tap Power Management Setup Tool.

Low Battery

System Settings

HDD

CPU

LCD

Tap the User Defined tab on the Power Management Setup dialog,
make the user settings you want, and then tap OK.
You must restart FIVA before the settings you made take effect.

Tap this icon.

Tap Power
Management
Setup Tool.
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Item

System Settings

Low Battery

HDD

CPU

LCD

Description

Use the settings in this area to specify the amount of time that
should pass after the last operation before the system goes into
the Standby Mode, and the amount of time before it goes into the
Hibernation Mode. For each of these settings, you can select 1,
2, 5, 10, 20, or 50 minutes.

Use the settings in this area to specify the level at which a battery
warning operation should be performed. You can also specify
whether the warning should be by audible alarm, dialog, or both.

Use this setting to specify the amount of time that should pass
after the last operation before power to the hard disk is cut off.
You can specify 15, 30 seconds, 1, 2, 5, 10, or 15 minutes. Power
is automatically restored whenever the hard disk is accessed.

Use this slider to specify the CPU Clock Speed as 50%, 75%, or
100%. Slowing down the CPU reduces system performance, but
it also extends battery life.

Use the settings in this area to specify the brightness of the LCD.
Dimming the backlight extends battery life. You can also specify
the amount of time that should pass after the last operation
before power to the display is cut off. You can specify 1, 2, 5, 10,
or 15 minutes.
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55555 Adjusting Display Brightness

Tap the  button on the System Management Toolbar and make the
settings on the dialog box that appears.

You can also make LCD brightness settings from the keyboard. See
page 27.
Press Fn +“1” ( ) to make the screen darker, and Fn +“2” ( )
to make it brighter.

66666 Changing the CPU Clock Speed

Controlling the CPU clock speed reduces power consumption and
helps to extend the life of the battery pack.
On the System Management Toolbar, tap the  button and make the
settings you want on the dialog box that appears. You can select one
of three CPU clock speed settings: 50%, 75%, or 100%.

Tap here.

Drag this slider to adjust
LCD Brightness.

Tap here.

Brightness Control icon
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77777 Adjusting Speaker Volume

Use the following procedure to adjust the sound output volume.

To adjust volume from Mobile Cockpit
Tap the Mobile Cockpit Volume Control icon to open the volume
control panel.
Drag the Volume Control slider up and down to adjust speaker
volume.

Volume Control icon

Tap here.

Drag this slider to adjust speaker volume.
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To adjust volume from the Taskbar
Tap the Volume Control icon on the right side of the Taskbar to
display the Volume Control panel. Drag the slider up and down to
adjust speaker volume.

To adjust volume using hot keys
Press Fn +“5” ( ) to decrease speaker volume, and Fn +“6”
( ) to increase it.

88888 Power Management for Specific Hardware

You can use the following procedure to cut off power to the hard disk,
USB, multi-communication port. Cutting off power to hardware
reduces power consumption and helps to extend the life of the
battery pack.
On the System Management Toolbar, touch the , , or  button to
cut off power to the corresponding hardware. Before cutting off power
to USB or the multi-communication port ( ), make sure first that the
hardware is not in use. Power to the disk ( ) is automatically turned
back on when the disk is accessed. To resume power to the USB or
the multi-communication port, tap the corresponding button again.

Volume Control icon

Tap here.

Drag this slider to adjust
speaker volume.

Tap one of these icons.
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99999 Show Properties

Tap these buttons to display the properties of the infrared port or PC
card.
On the System Management Toolbar, tap the  button to display
infrared port properties or  to displays PC card properties. The
properties dialog box shows the settings and status of the infrared
port and PC card. See page 96 for information about the infrared
port, and page 98 for information about the PC card.

00000 Displaying the Battery Report

Battery Report Tool shows the current status of the battery.
On the System Management Toolbar, tap the  button to display
information about the connected battery pack. See “Charging the
Battery Pack” on page 31.

When the battery pack is being used alone, the Battery Report shows
the estimated amount of operation time remaining with the battery
pack.
When the AC adaptor is connected to FIVA, the Battery Report shows
the amount of time until battery is fully changed.

Indicates battery power only.

The screen in the left
shows that your FIVA is
under battery power only.

Battery Report under battery power only.

Tap here.
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qqqqq Battery Level Indicator

The Mobile Cockpit also includes a green graphic meter that shows
the current battery status. When the battery pack is being used
alone, this meter shows the estimated amount of operation time
remaining with the battery pack. When the AC adaptor is connected
to FIVA, the meter shows the amount of time until a full charge is
reached.

wwwww Putting the System Into the Standby Mode

Tapping the Mobile Cockpit  icon puts the system into the Standby
Mode, while the  icon puts the system into the Hibernation Mode.

You can also enter the Standby Mode or Hibernation Mode using the
following procedure.
Entering the Standby Mode or Hibernation Mode from the Keyboard
Press Fn  + “3” to enter the Standby Mode or Fn  + “4” to enter the
Hibernation Mode.

Indicates AC adaptor in use.

Battery Report when AC adaptor is connected.

Battery status meter

The values shown by the battery
report tool differ according to
the operating environment.

Standby Mode
Hibernation Mode
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eeeee Entering the Hibernation Mode

See w above.

rrrrr Using Mobile Cockpit Help

To display on-line help for Mobile Cockpit, select Mobile Cockpit
Help from the Mobile Cockpit menu or tap the ? button on the toolbar.

Tap here.
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Using the Battery Pack

A charged battery pack lets you run FIVA without connecting the AC
adaptor. The following describes various power management
functions that help to make battery pack operation more efficient.

Note
• See page 29 for information about attaching and removing the

battery pack. See page 31 for information about charging the
battery pack.

• The battery pack naturally discharges even when you are not using
it. To avoid problems due to premature rundown of the battery
pack, charge it just before you plan to use it or charge the battery
pack as you use it.

Checking the Current Charge Level of the Battery Pack
The battery pack discharges naturally even when you are not using it.
Make sure you charge the battery pack fully before trying to use it to
power FIVA.
You can use any of the following three methods to check the current
charge level of the battery pack.

Checking the Power Indicator Lamp Color
The  indicator lamp flashes amber if the battery charge level drops
while FIVA is operating under battery power only. When this happens,
connect the AC adaptor and charge the battery. If you continue to
use FIVA under the low power condition, FIVA will automatically enter
the Hibernation Mode when the battery charge level drops more. See
page 37.

Important • You can specify the trigger level at which the low battery warning
appears. See page 82 for details.

• Turning on power while battery power is below the trigger level for
low battery warning causes the warning message to appear on the
display (Battery power is below XX%.) and power to turn off
automatically. When this happens, connect the AC adaptor to
power FIVA.
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Note
Battery charging is performed any time the AC adaptor is connected,
even while FIVA is turned on. Note, however, that a full charge is
attained more quickly when FIVA is turned off.

Checking the Battery Indicator Lamp Color
A green  indicator lamp is lit while FIVA is being powered by the
AC adaptor indicates that the battery is fully charged. Charging is in
progress when the  indicator lamp is amber. See pages 87 to 88.

Checking with Mobile Cockpit
Mobile Cockpit’s battery monitor function lets you graphically view the
charge level of the battery at any time. See page 87.

Using the Battery Pack Effectively
The amount of operating time you get from the battery pack is greatly
affected by operating conditions and how you use it.
FIVA’s  mobile computing Power Management functions help to
ensure that you get maximum power out of the battery pack.

Forced Hibernation Mode
To help ensure that you do not lose application data files, FIVA goes
into forced Hibernation mode whenever the battery charge level
drops below a certain point. When this happens, connect the AC
adaptor and press the power switch to recover from the Hibernation
mode. See page 37.

 Power Indicator Meaning

Lit Amber FIVA being powered by battery pack.

Flashing Amber When using battery power only,
indicates the Standby Mode.

Flashing Red When using battery power only,
indicates low battery power.

Lit Green FIVA being powered by AC adaptor.

Flashing Green Standby Mode (AC adaptor is used)
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When to Replace the Battery Pack
The battery pack is a consumable item, and after long use the
amount of operating time provided by a fully charged battery can
become quite short. This indicates it is time to replace the battery
pack with a new one.
When the “Deteriorate Rate” of the Battery Report reads less than
30%, it is probably time to replace the battery pack.

Important The values that appear in the Battery Report are provided for general
reference only. Actual operability of the battery is affected by
operating environment and other conditions.

Using the Large-capacity Battery Pack
Use the optionally available battery pack (MPC-173BAT or MPC-
174LBAT) when you need to operate FIVA for longer periods without
AC adaptor power. The large-capacity battery pack provides about
four hours of continuous operation on a full charge. The operation of
the standard battery pack and the large-capacity battery pack
included in standard is the same. (Attaching/Removing)

Important Be sure you use the correct battery pack. On the “Options List” (page
124) , find the battery pack whose model number matches the
number marked on the battery pack.

Shows the number of times the
battery pack was charged and
other information.

Tap here.



Chapter 3
Supplementary
Information
This chapter contains information
about how to connect
peripherals and what to do
when you experience
problems.
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Note the following important points before connecting a peripheral.
• Some peripherals require changes in FIVA settings.

Some peripherals require certain settings to be made before they
can be used.

• Use only special cables for connections.
Use only the specified cables to connect peripherals. Even if the
shape of a connector on a cable appears the same as that for the
specified cable, it may not work properly. Carefully check to make
sure you are using the correct cables.

• Carefully read the documentation that comes with the
peripheral.
The peripheral connections described in this user’s guide are
general examples. Actual connection methods and settings
depend on the peripheral. When connecting a peripheral, use the
procedures provided in this user’s guide in combination with the
documentation that comes with the peripheral.

Connecting a Peripheral to FIVA

A “peripheral” is a device, like a printer or external floppy disk drive
that you connect to FIVA. The following procedure describes how to
connect a peripheral to FIVA and how to install a PC card.

Important For information about peripherals that are not explained in this user’s
guide, see a documentation that comes with the peripheral.

Connecting to the Communication Port
Remove the connector cover from the right side of FIVA, and plug in
the connector of the cable as far as it will go.

If your FIVA has a built-in fax modem, it can perform high-speed data
communication, and send and receive faxes. Connect the supplied
modular cable to the communication port to perform these functions.

Modular cable

Telephone line
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Note
Never move FIVA with the communication cable connected to the
communication port. Doing so can damage the communication port
or cause the communication to bread. etc.

Infrared Data Communication

To exchange data, you have to start up the pre-installed infrared
software.
1. On the Taskbar, tap the Infrared Monitor icon to open the Infrared

Monitor screen.

2. Tap the Options tab, and then check the checkbox next to the
“Enable infrared communication on”.

3. Tap the OK button.

Infrared communication port

Check this option.

Infrared Monitor icon (infrared disabled)
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4. On the Taskbar, check the Infrared Monitor icon to make sure that
it has changed to the form that indicates infrared communication is
enabled.

FIVA comes with software named Quick Beam, for data exchange
using the optional cradle. See the documentation that comes with the
cradle for information about how to use it.

Important Leaving the infrared monitor on battery life. Be sure to power FIVA
using the AC adaptor whenever performing infrared communications.

USB Connection 
The USB (Universal Serial Bus) lets you connect or disconnect
peripherals without turning off FIVA power. There is one USB
connector built into FIVA and one more on the port replicator or
cradle.

USB devices include the mouse, keyboard, printer, etc. Each requires
a USB cable for connection. Use the appropriate cable for the device
you are connecting.
A peripheral connected to the USB port draws power from the port.
Click the USB icon and enable power before connecting a peripheral
to the USB port. See “8 Power Management for Specific Hardware”
on page 86 for more information.

Connect the USB cable to the USB port on the
side of FIVA. Orient the connector of the cable
so the side marked  is facing upwards.

Infrared Monitor icon (infrared enabled)
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Loading PC Card and Expansion Memory

Using a PC Card
FIVA has one “PC Card Standard PCMCIA TYPE II” PC card slot. The
following describes the types of PC card that can be used.
• LAN card
This type of card makes it possible to interconnect multiple
computers and exchange data using Ethernet.
• Other SS wireless cards

Important • Long term use of PC card that generates a lot of heat can cause
unstable card operation and malfunction.

• Never install or remove a PC card while an application is running.
• Never install or remove a PC card while system operation is

suspended or in Hibernation Mode. Doing so can cause data to be
deleted.

Note
You can use the “Product Recovery CD-ROM” that comes bundled
with FIVA to restore the hard disk. Use the optional CASIO MPC-
142CDDE CD-ROM drive to access the CD-ROM.

A PC card must be oriented correctly when you insert it into the slot.
Forcing a card into the slot upside-down can damage its connectors.
Always make sure the card oriented correctly when inserting it into
the slot.

Important • Make sure you insert the PC card into the slot as far as it will go. An
incorrectly inserted card can result in incorrect installation of the
card’s driver and malfunction.
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Normally when you insert a PC card, FIVA detects it automatically
loads the required software. If automatic installation is not performed,
follow the instructions that appear on the screen to install the
software.
• Before removing the PC card from the slot, first tap the Mobile

Cockpit PC Card button to disable the PC card and then remove it.

Using the Port Replicator

The optionally available port replicator (MPC-160PR) provides
connection ports for a PS/2 device (for mouse or keyboard), a USB
device, a monitor, an RS-232C port device, a printer, and an external
floppy disk drive.

To connect FIVA to the port replicator
1. Quit all applications and shut down the system.
2. Disconnect the AC adaptor and all peripheral cables.

3. Turn over the FIVA.

Select the card here.

Tap the Stop button.
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4. Aligning the replicator connector on the bottom of FIVA with the
connector on the port replicator, lower FIVA onto the port replicator.
Make sure the hooks on the replicator fit into the holes on the
bottom of FIVA. FIVA is properly attached to the replicator when
the eject lever is fully extended.

To remove FIVA from the replicator
1. Quit all applications and shut down the system.
2. Disconnect the AC adaptor and all peripheral cables.
3. Pressing the port replicator’s eject lever, lift FIVA from the port

replicator.

Important • Never transport FIVA while it is mounted on the port replicator. If
you do, FIVA may suddenly fall off and become damaged.

• Using a number of peripherals in combination with the port
replicator can put large power demands on the FIVA power supply.
Because of this, you have to use the AC adaptor whenever FIVA is
connected to the port replicator.

Hooks

Eject lever
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Using the Floppy Disk Drive
Connecting the optionally available floppy disk drive (MPC-140FDDE)
lets you use both 720KB and 1.44MB floppy diskettes. A floppy disk
drive lets you store your data on diskettes, and exchange data with
another computer. FIVA is set up so you can use the external disk
drive as soon as you connect it.

To connect the floppy disk drive
1. Connect FIVA to the port replicator (page 99).
2. While FIVA is shut down, connect the floppy disk drive to the

appropriate connector of the port replicator.

Press the connector in until the locks on both sides engage.
The access lamp on the floppy disk driver lights or flashes whenever
data is being written to or recalled from a disk. Never remove the
floppy disk from the drive while the access lamp is lit or flashing.
Doing so can cause data to be corrupted, or even lost data entirely.

To write protect a floppy disk
Floppy disks have a write protect tab that you can use to protect the
data on it from accidental deletion or change.

Write protect tab

Data can be written to
the disk.

Data cannot be written
to or deleted from the
disk.

Make sure the connector is oriented
correctly when you plug it in.
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Using an External Monitor
Use the following procedures to connect a CRT or LCD monitor to
FIVA for big-screen viewing. Changing the display mode enables use
of a mouse or other pointing device in place of the stylus.

To connect a monitor
1. Connect FIVA to the port replicator (page 99).
2. While FIVA is shut down, connect the monitor to the appropriate

connector of the port replicator.
Making sure the connector is oriented correctly, connect the cable
from the monitor to the appropriate port on the port replicator.
Plug the power cord of the monitor into a wall outlet. See the
documentation that comes with the monitor for details on its use.

3. Turn on FIVA and start up Windows 98.
4. Press Fn + “0” to switch to the external monitor

Each press of Fn + “0” cycles through monitor functions in the
following sequence: LCD → CRT* → LCD and CRT* → LCD.
CRT* = External monitor
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Colors Size (Pixels)

16-bit 640×480/800×600/1024×768

256 Colors 640×480/800×600/1024×768

16 Colors 640×480/800×600/1024×768

Change these settings.

Important The display screen momentarily goes blank whenever you change
from one monitor function to another. This is normal and does not
indicate malfunction.

Note
You can specify the resolution and number of colors when using an
external monitor alone. Right tap on the Windows 98 desktop, and on
the menu that appears select Properties.

• Tap the Settings tab, and then make the Colors and Screen
area settings you want.

The following table shows the setting combinations that can be made
for Colors and Screen area.

• The actual Colors and Screen area settings you will be able to
make depend on the type of monitor you are using.
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Connecting a Mouse or External Keyboard
You can connect a mouse or external keyboard to the PS/2 port. Use
the standard Windows 98 properties screen to make mouse settings.

Connecting a USB Device
Use the USB port to connect separately available USB compatible
device.

Connecting an RS-232C Peripheral
The RS-232C port, which is named COM1 under Windows 98, can be
used to connect serial device. Note that you cannot use the
RS-232C port while the built-in modem is enabled. Use Mobile
Cockpit to switch between the built-in modem and the RS-232C port.

Connecting a Printer
Use the parallel port to connect a separately available printer or other
parallel device. This port is named LPT1 under Windows 98.
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Troubleshooting

This section describes what you should do whenever you start to
experience problems with operation of FIVA, its peripherals, or the
applications you are running.

Basic Troubleshooting

Note the following important points whenever you are
experiencing problems.
1. Take your time.

If the system seems to hang up, resist the urge to turn off power,
click things on the display, or press keyboard keys. The operation
you are performing may simply require a bit more time.

2. Take notes of information that appears on the display.
Message, numbers, and codes that appear on the display may
provide hints to the cause of the problem and what you need to
overcome it. Keep notes of such information when it appears on
the display.

3. Try to determine the possible cause of the problem.
If FIVA is the source of the problem, or is it being caused by a
peripheral or application? Does the same operation or conditions
always cause the same problem?
Is there something distinctive about the problem?

4. Check the documentation and on-line help.
You may be able to find information that leads to the solution of
the problem in the documentation or on-line help of FIVA, its
peripherals, or your applications.
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Model

Serial Number (on the bottom panel)

Memory Capacity(MB)

FIVA Hard Disk Capacity (GB)

Hard Disk Free Space (MB)

Battery Pack (Used/No Used)

Peripherals

External Monitor

Printer

PC Card

Other Peripherals

Software Windows Version

Remarks
All applications running

when problem occurred

System Outline
Have the following information handy whenever you request user
support.

Memo about your system

Other information about FIVA can be found by visiting the
CASSIOPEIA Website at: http://www.casio.co.jp/English/system/

http://www.casio.co.jp/English/system/
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FIVA Malfunction
Symptom

FIVA is emitting smoke and heat.

FIVA malfunction

You don’t know what to do.

Recommended Action

Immediately turn off power and unplug the
AC adaptor from the wall outlet.

Contact your original dealer or authorized
distributor. Have the following information on
hand.
• Product name and model number
• Date of purchase
• Current status and the names of

applications being used

Contact your authorized distributor. Have the
following information on hand.
• Product name and model number
• Date of purchase
• Current status and the names of

applications being used
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Power Supply

Note
For safety reasons, FIVA is designed so CPU Clock Speed slows
down whenever internal temperature rises above a certain level. If
operation continues, FIVA automatically enters the Hibernation Mode.

Symptom

Power does not turn on.
• Power indicator lamp is flashing red.
• Power turns on but immediately turns

off.
• Nothing happens when the power

switch is pressed.

Power turns on, but the system does not
start up.
• The system does not start up when

power is turned on in the Hibernation
Mode.

Power turns off.
• FIVA suddenly goes into the

Hibernation Mode and power turns off
while you are using it.

Battery pack does not supply much
operation time, even after a full charge.

Recommended Action

Use the AC adaptor to power FIVA.
• Use a fully charged battery pack. If the

battery pack has small charge when
power is turned on, a warning message
appears momentarily and power turns
off.

Leaving power turned on, press the
RESET switch on the bottom of FIVA.
Note that the RESET operation will result
in loss of any data saved by the
Hibernation Mode.

Wait for a while to allow the interior of
FIVA to cool off. See the Note  at the
bottom of this page.

Use the AC adaptor or a fully charged
battery pack to power FIVA. A low battery
pack can cause power to suddenly turn
off.

Open the Mobile Cockpit Battery Report
and check the battery inferior rate. If it is
below 30%, you may need to replace the
battery pack with a new one.
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Display Problems

Symptom

Nothing on the display, Power indicator
lamp is not lit.

Display has gone blank.

The operator cannot remember the
Windows 98 password.

The operator cannot remember the
password registered in the BIOS
settings.

Display contents are difficult to see.

Display is dim.

Nothing appears on the display.

Recommended Action

Press the power switch to turn on power.

Press Shift . FIVA’s power saving
function causes the display to go blank if
no operation is performed for some time.
See page 88.

Input a new user name in the Windows
Log On screen, or restore the system to
its factory defaults.

With your FIVA model number on hand,
contact your original dealer or authorized
distributor.

Reorient FIVA so you can view the
display at a different angle.

Use Fn + “1” or Fn + “2” to adjust
display brightness. If the display remains
dim at a bright setting, it may mean that it
has reached the end of its service life.
With your FIVA model number on hand,
contact your original dealer or authorized
distributor.

Press Fn + “0” to cycle through monitor
functions until the display you want to
use it selected. See pages 27 and 102.
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Symptom

Cannot perform infrared data communi-
cation.

Cannot send data correctly using
infrared data communication.

Sound output is too slow.

Sound output is broken.

Audio skips during audio playback or
communication errors occur during
communication from the multi-
communication port.

Occasional inability to record from the
microphone or output sound from the
speaker.

Recommended Action

Make the proper infrared port settings.
• Make sure the data transfer speed set

for FIVA is the same as that set on the
other device.

• Make sure there are no obstructions in
the infrared path between the two
devices.

Make sure the data transfer speed set for
FIVA is the same as that set on the other
device.
• Change the distance between FIVA and

the other device.
• Move the two devices to an area that is

not exposed to direct sunlight or
fluorescent lighting.

Turn off sound playback and then turn it
back on again.

Tap the Mobile Cockpit CPU icon and
then use the slider to set the CPU Clock
Speed to 100%.
• Quit other applications before the

adjustment.

These conditions are caused by any of
the followings.
• Changing the power supply between

AC adaptor power and battery pack
power

• Running the battery report
• Large load on the FIVA CPU
• Reduction of CPU clock speed due to

internal overheating

Change the volume control setting or re-start
FIVA. See page 85 of this User’s Guide for
information about using the speaker.

Software Problems
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Symptom

Built-in modem does not work.
(MPC-501M62E only)

The microphone suddenly fails during
recording or output from the speaker
suddenly cuts off during playback

Recommended Action

• On the BIOS Settings screen, change
the COM1 Port setting to “Multi-
Communication Port.” See page 78 of
this User’s Guide.

• Check the Mobile Cockpit screen to see
if the Port Replicator icon is enabled.
See page 79 of this User’s guide.

• Change the audio volume setting or
restart the application.
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Symptom

Power indicator lamp flashes red
immediately after charging.

FIVA beeps during operation.

FIVA suddenly hangs up.

System runs too slow (1).

System runs too slow (2).

System runs too slow (3).

Displayed date and time are wrong.

The screen temporarily goes white
when FIVA is starting up or when the
display mode is changed.

Recommended Action

Purchase a new battery pack and replace
the current one. Battery packs tend to lose
their ability to charge after long use.

Connect the AC adaptor and charge the
battery. Beeping indicates low battery power.

• If you suspect that the problem is due to
low battery power, connect the AC adaptor
and charge the battery.

• If you suspect that the problem is being
caused by the application you are using,
press the RESET switch and restart
Windows 98.

• Try turning power off and then back on
again.

• Memory may be low, which means you
have to increase it by installing a
separately available DIMM board.

If Power Management is causing the system
to go into the Economy Mode, try changing
the Normal Mode or turning Power
Management off. See page 81.

Turn power off and wait a while. Normal
operation should return after FIVA has a
chance to cool off.

• Use the Control Panel to set the correct
date and time.

• If the date and time seem to require
frequent setting, it may mean that the clock
battery is low. Contact your original dealer
or authorized distributor about having the
clock battery replaced.

This is normal and does not indicate any
malfunction or problem.

General Operation Problems
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Symptom

Hot keys do not work.

Mobile Cockpit is not displayed.

Windows 98 is hung up.

General Operation Problems (continued)

Recommended Action

Tap the Taskbar’s Start button and start up
Mobile Cockpit from the Programs menu.

• If Mobile Cockpit is not running, tap the
Taskbar’s Start button and start up Mobile
Cockpit from the Programs menu.

• If the Mobile Cockpit toolbar is hidden, tap
the Mobile Cockpit icon on the Taskbar
and then uncheck the Hide option on the
menu that appears.

• Press Ctrl + Alt + Del , and then tap
the Shut Down button. Next, restart
Windows 98.

• If Ctrl + Alt + Del  does not work,
press the RESET switch and then restart
the system.
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The following explanation, pages 114 to 117, is about the Terminal
Equipment (hardware modem) embedded in CASSIOPEIA FIVA
series (models with the modem) and described by following the rules.
The Terminal Equipment is operable and compliant with the
regulations in the United States and Canada only.
For users of CASSIOPEIA FIVA series resident in other countries and
some models that do not embed the Terminal Equipment (models
without the modem), the description and the instruction of the
equipment are not applicable.

Using the Terminal Equipment MBH7MD23-8556CA

MBH7MD23-8556CA is a hardware modem designed for being
embedded in small personal computers such as a notebook
computer.

About the actual operation and setting of hardware and software,
refer to the user operation manual of the products which have an
embed MBH7MD23-8556CA.

For users in the United States
This equipment complies with Part 68 of the FCC rules. On the back
side of this equipment is a label that contains, among other
information, the FCC registration number and ringer equivalence
number (REN) for this equipment. If requested, this information must
be provided to the telephone company.

USOC Jack,RJ11C is available to this equipment.

An FCC compliant telephone cord and modular plug is provided with
this equipment. This equipment is designed to be connected to the
telephone network or premises wiring using a compatible modular
jack which is Part 68 compliant. See Installation Instructions for
details.

The REN is used to determine the quantity of devices which may be
connected to the telephone line. Excessive RENs on the telephone
line may result in the devices not ringing in response to an incoming
call. In most, but not all areas, the sum of RENs should not exceed
five (5.0). To be certain of the number of devices that may be
connected to a line, as determined by the total RENs, contact the
local telephone company.
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If the terminal equipment MBH7MD23-8556CA causes harm to the
telephone network, the telephone company will notify you in advance
that temporary discontinuance of service may be required. But if
advance notice isn’t practical, the telephone company will notify the
customer as soon as possible. Also, you will be advised of your right
to file a complaint with the FCC if you believe it is necessary.

The telephone company may make changes in it’s facilities,
equipment, operations or procedures that could affect the operation
of the equipment. If this happens the telephone company will provide
advance notice in order for you to make necessary modifications to
maintain uninterrupted service.

If trouble is experienced with this equipment MBH7MD23-8556CA, for
repair or warranty information, please contact CASIO INC. (973-361-
5400). If the equipment is causing harm to the telephone network, the
telephone company may request that you disconnect the equipment
until the problem is resolved.

This equipment cannot be used on public coin phone service
provided by telephone company. Connection to party line service is
subject to state tariffs. (Contact the state public utility commission,
public service commission or corporation commission for
information.)

The Telephone Consumer Protection Act of 1991 makes it unlawful for
any person to use a computer or other electric device, including fax
machines, to send any message unless such message clearly
contains in a margin at the top or bottom of each transmitted page or
on the first page of the transmission, the date and time it is sent and
an identification of the business or other entity, or other individual
sending the message and the telephone number of the sending
machine or such business, other entity, or individual.

In order to program this information into your fax machine, you should
see your FAX application software manual.

According to the FCC’s electrical safety advisory, we recommend that
you may install an AC surge arrestor in the AC outlet to which this
equipment is connected. Telephone companies report that electrical
surges, typically lightning transients, are very destructive to customer
terminal equipment connected to AC power source and that this is a
major nationwide problem.
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This equipment is registered with the FCC under Part 68 as a
component device for use with CASIO COMPUTER CO., LTD. models
CASSIOPEIA FIVA Series. In order for the FCC registration of this
product to be retained, all other products used in conjunction with
this product must also be FCC Part 68 registered for use with this
host. If any of these components are not registered, then you are
required to obtain FCC Part 68 registration of the assembles
equipment prior to connection to the telephone network. Part 68
registration requires that you maintain this approval and as such are
responsible for the following:

Any component added to your equipment, whether is bears
component registration or not, will require a Part 68 compliance
evaluation. You may need to test and make a modification filing to
the FCC before that new component can be used;

Any modification/update made by a manufacturer to any
registered component within your equipment, will require a Part
86 compliance evaluation. You may need to test and make a
modification filing to the FCC before that modified component can
be used;

If you continue to produce this component you are required to
comply with the FCC’s Continuing Compliance requirements.

Therefore is all recommended that only FCC Part 68 registered
devices bearing the ‘CN’ or ‘CE’ equipment code as part of FCC
registration number. be used. To determine if your particular
component is appropriately approved, look for the FCC
registration number on all components and ensure that the
classification code ‘-CN-’ or ‘-CE-’ is part of that number. Refer to
the FCC Registration number on this products as an example.”

If the telephone Company requests that you supply the FCC
Registration number and REN of the device you are connecting,
please supply the FCC Registration numbers from all component and
host devices that have a direct PSTN connection (i.e. have a REN
stated on the label) and the highest REN.

Notice Concerning FCC Redial Regulations
Note that federal law prohibits you from using software that is not in
compliance with FCC rules that regulate redialing on the computer or
other device where this modem is installed.



117

3

For users in Canada
NOTICE:  The Industry Canada label identifies certified equipment.
This certification means that the equipment meets
telecommunications network protective, Operational and safety
requirements as prescribed in the appropriate Terminal Equipment
Technical Requirements document(s). The Department dose not
guarantee the equipment will operate to the user’s satisfaction.

Before installing this equipment, users should ensure that it is
permissible to be connected to the facilities of the local
telecommunications company. The equipment must also be installed
using an acceptable method of connection. The customer should be
aware that compliance with the above conditions may not prevent
degradation of service in some situations.

Repairs to certified equipment should be coordinated by a
representative designated by the supplier. Any repairs or alterations
made by the user to this equipment, or equipment malfunctions, may
give the telecommunications company cause to request the user to
disconnect the equipment.

Users should ensure for their own protection that the electrical ground
connections of the power utility, telephone lines and internal metallic
water pipe system, if present, are connected together. This
precaution may be particularly important in rural areas.
Caution: Users should not attempt to make such connections
themselves, but should contact the appropriate electric inspection
authority, or electrician, as appropriate.”

NOTICE: The Ringer Equivalence Number (REN) assigned to each
terminal device provides an indication of the maximum number of
terminals allowed to be connected to a telephone interface. The
Termination on an interface may consist of any combination of
devices subject only to the requirement that the sum of the Ringer
Equivalence Numbers of all the devices does not exceed 5.”

The Ringer Equivalence Number of This terminal equipment is 0.4.
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ITU-T V.21
ITU-T V22bis
ITU-T V32

ITU-T V32bis

ITU-T V34

V34bis

V.90

K56flex

ITU-T V.27ter
ITU-T V.29

ITU-T V.17

Function Protcol Speed Comment

Network control functions Automatic Send and Receive by built-in NCU

Modem protocols
Conforms to the following protocols and possible to
communicate in full duplex V.21/V.22bis/V.32/V.32bis/
V.34/V34bis/V.90/K56flex/V.27ter/V.29/V.17

Data compression
protocols

Conforms to MNP 5, ITU-T V.42bis

Error control protocols Conforms to MNP 4, ITU-V.42

300
2400, 1200
9600, 4800
14400, 12000, 9600,
7200, 4800
28800, 26400, 24000,
21600, 19200, 16800,
14400, 12000, 9600,
7200, 4800, 2400
33600, 31200, 28800,
26400, 24000, 21600,
19200, 16800, 14400,
12000, 9600, 7200,
4800, 2400
56000, 54667, 53333,
52000, 50667, 49333,
48000, 46667, 45333,
42667, 41333, 40000,
38667, 37333, 36000,
34667, 33333, 32000,
30667, 29333, 28000
56000, 54000, 52000,
50000, 48000, 46000,
44000, 42000, 40000,
38000, 36000, 34000,
32000
4800, 2400
9600, 7200
14400, 12000, 9600,
7200

There are two modes,
Long and Short in each
speed respectively

Data
communication
(Send and
Receive)

Data
communication
(Receive only)

FAX
communication

Main functions of the modem
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MBH7MD23-8556CA
communication connector

Connecting to telephone line
The dedicated modular cable that comes with the modem shall be
used to connect the modem to the telephone line.
In this case, if the telephone line is available through the modular
jack, it is possible to connect the modem to the telephone line with
the dedicated communication cable directly.
Otherwise, an adapter is required or modification of the telephone
line socket might be necessary.
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Connecting to the FIVA
Turn off the power of the FIVA first and then connect as depicted
below.

* Modular cable:
Part No.: PX735-UL-MC
CASIO INC.
(Toll free: 973-361-5400)

Connector for communication
(for connection to the dedicated modular cable)

Dedicated modular cable*
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For the connection to the telephone line, connect the modular jack
directly as shown below or connect via Inline Coupler.

Caution on operation of the product

To use this product, operate as instructed below since this is
designed to be embedded in the FIVA.

1. The product must be set in a case upon use.
2. Do not leave the product in the area such as hot and humid or

exposed to direct sunlight since the product is precisely designed.
3. Do not spill any liquid such as water on the product.
4. Do not touch the electric terminals without discharging static fully

otherwise it will cause electric static damage.
5. In case the product is used exceeding the maximum specification,

there is possibility that LSIs inside might be damaged permanently.
Therefore, it is favorable to use the product under the normal
operation conditions.  If the product is left above the normal
operating conditions, it might be possible to affect to the reliability
of the LSIs.

Modular cable

Modular cable

Telephone Line

Telephone Line

Inline Coupler
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Specifications

Sound Functions

Input
Device

Interfaces

Expanded

Memory (RAM)

Monitor
Functions

Memory

Model MPC-501M62E MPC-501M63E MPC-501M63O

CPU National Semiconductor Geode (MediaGX)
CPU operating frequency/

Built-in Cache Memory
200MHz/16KB

Main 32MB

32/64MB (one expansion RAM slot, 96MB maximum total)

ROM 256KB (BIOS), supports plug and play
Video RAM 2.5MB (UMA)

Hard Disk (Built-in) 10GB 15GB
Monitor Device 6.7-inch HAST TFT color LCD (with backlight); touch

panel screen

Resolution*1 SVGA (800 × 600 dots), 65,536 colors
Keyboard 10-key pad; arrow keys; control keys
Touch Screen Analog film resistor touch panel

Monaural speaker (built-in); monaural microphone (built-
in); PCM (Sound Blaster 16 compatible) sound source

Monaural speaker (built-in)
Monaural microphone (built-in)
PCM (Sound Blaster 16 compatible) sound source
USB, 1 channel

Built-in IrDA1.1 compliant infrared port
(Data Transfer Rate: 4Mbps, 115.2Kbps/ASK maximum)

Communi-
cation Ports

USB × 1
External FDD × 1
Serial (D-SUB 9-pin male) × 1
Parallel (D-SUB 25-pin female) × 1
Video (mini D-SUB 15-pin female) × 1
PS/2 × 1

PC Card Slot Type II × 1 slot (Card Bus compliant)
Power Management Auto or manual settings
Timekeeping Clock battery backup
Security Power on password

Sound
Functions

Modem (56kpbs receive,
V.90; FAX: 14.4kbps)

With Port
Replicator
(option)

Serial
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*1 Resolution indicates the number of vertical and horizontal dots. Larger numbers indicate
higher resolution, clearer images, and a larger display area.

Though the FIVA TFT LCD is a very high quality display device, there may be times
that brightness is uneven and when fine specs appear on the screen. Also, some dots
may not illuminate or some dots may stay illuminated at all times. All of this common
for liquid crystal displays, and does not indicate malfunction.

Battery
Charging Time

Type Lithium ion battery (Rating: 11.1V, 3000mAh) (corresponds to the MPC-174LBAT)

Power Off: Approximately 4 hours

Dimensions 206(W) × 46(D) × 25(H) mm (8.1"(W) × 1.81"(D) × 0.98"(H))

Weight 320g

Power 45W

by AC adaptor 16V AC adaptor (Input: 100 to 240V AC, 50/60Hz)

Dimensions with battery 210(W) × 151(D) × 28(H) mm (8.3"(W) × 5.9"(D) × 1.1"(H))

pack (excluding projections)

Approximate weight with

battery pack
1020g (2.24lbs) 1005g (2.21lbs)

Operating Environment Temperature: 5°C to 35°C (41°F to 95°F); Humidity: 30 to

90% (non-condensation)

Standard Pre-installed Software Microsoft® Windows® 98 Second Edition None

Applications Mobile Cockpit, Quick Beam Suite None

Battery
Pack
(Included)

6 hours
• Actual times depend on operating conditions and

connected peripherals.

Approximate
Operation
Time
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Options List

The useful options shown below are available for use with the FIVA MPC-501 Series.

Memory Expansion DIMM Board Port Replicator
(Product No. MPC-151RAM) 32MB (Product No. MPC-160PR)

MPC-152RAM) 64MB

Floppy Disk Drive CD-ROM Drive
(Product No. MPC-140FDDE) (Product No. MPC-142CDDE)

Large-capacity Battery Pack Battery Pack
(Product No. MPC-174LBAT) (Product No. MPC-173BAT)

AC Adaptor Battery Pack Charger
(Product No. MPC-577ADPE) (Product No. MPC-570CHG)
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FIVA User’s Guide
(MPC-501 series)

1st. ed. 2001-09

CASIO COMPUTER CO., LTD.
6-2, Hon-machi 1-chome

Shibuya-ku, Tokyo 151-8543, Japan

Notes
• This guide cannot be reproduced or duplicated in any form, in part or in whole, without

written permission from CASIO COMPUTER CO., LTD.
• The content of this guide is subject to change without notice.
• CASIO has, to the best of its ability, endeavored to make this guide as accurate as possi-

ble. However, if any unclear portions or omissions are found, please contact your dealer.

Descriptions and specifications furnished herein the User’s Guide by CASIO Computer Co.,
Ltd. are believed to be accurate and reliable. However, CASIO reserves the right to make
changes or improvements in the descriptions and specifications without any advanced notice.
CASIO does not assume any liability arising from the use of the contents, nor for any
infringements of patents or other rights of third parties which may result from the use of the
contents.

• Microsoft, MS-DOS and Windows are registered trademarks of Microsoft Corporation in

the United States and/or other countries.

• PS/2 is a registered trademark of International Business Machines Corporation in the

United States.

• smARTwriter, smARTscribble and Quick Trainer are trademarks or registered trade-

marks of Advanced Recognition Technologies in the United States.

• Other company, product and service names used herein may also be trademarks or

service marks of respective companies.

International ENERGY STAR® Program
As a member of the International ENERGY STAR®

Program, CASIO products have been judged to
meet International ENERGY STAR®  standards.
ENERGY STAR®  is a U.S. registered mark.

Power Plug and AC Adaptor

Note
AC cord plug and wall outlet illustrated in this User’s Guide shows the
two-pin plug type. It may not be the same shape of AC cord plug used
in your area.
FIVA’s AC adaptor has an automatic voltage switching circuit (input:
100 to 240VAC, 50/60Hz) and lets you use your FIVA under AC power
virtually anywhere in the world without having an extra power-transformer.
Note, however, that AC cord plug shape differs according to area you
are in. Make sure that the AC cord you will use can fit into wall outlet
and is compliance with the local electric safety standard.

© 2001 CASIO COMPUTER CO., LTD. All rights reserved.

MPF0101098-01
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6-2, Hon-machi 1-chome
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Thank you for purchasing the CASIO FIVA MPC-501.
This guide describes the basic operations of the
product.
Read this guide in its entirely before handling or
operating the product, and keep it close at hand so it
can be easily referenced.
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FIVA
User’s Guide

(MPC-501 series)

This document is printed using
environmentally friendly soy ink.
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